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E. LINUX Server

1. Conectarea (login) şi deconectarea (logout)
Sistemul SUSE LINUX poate porni automat în mediul desktop dacă anterior a fost activat
automatic login din modulul de administrare. În caz contrar pentru conectare trebuie introdus
numele utilizatorului (Username) şi parola corespunzătoare (Password) care au fost definite
anterior.

Figura E.1.

În funcţie de mediul desktop instalat, programul utilizat în sesiune poate fi KDM pentru mediul K
Desktop sau GDM pentru desktop-ul GNOME.
GDM şi KDM diferă în funcţionalitate şi de aceea sunt tratate separat.

1.1 Introducere în GDM
Un ecran de login GDM are două componente: câmpul de introducere a numelui utilizatorului şi
a parolei şi un meniu.
Meniul conţine trei opţiuni:
Language Selectaţi limba utilizată în sesiunea GNOME. Se poate schimba limba temporar
pentru viitoarea sesiune sau în mod permanent ca alegere implicită.
Session Determină tipul sesiunii (GNOME, KDE, etc.). Schimbaţi această opţiune dacă doriţi ca
viitoarea sesiune să utilizeze alt mediu desktop decât cel implicit. Modificarea poate fi temporară
sau poate fi implicită pentru toate sesiunile următoare.
Actions Alegeţi acţiuni legate de sistem ca închiderea sistemului, repornirea sau configurarea
cu login manager.



Pentru terminarea sesiunii se alege Log Out din meniul System. La deconectare (logout) se
poate salva starea sesiunii curente, se poate termina sesiunea lăsând sistemul pornit, se poate
reporni sistemul sau se poate opri calculatorul cu shutdown.

1.2 Introducere în KDM
Un ecran de login KDM are două elemente principale. El are câmpuri de introducere pentru
numele utilizatorului şi pentru parolă şi un meniu.
Session Type Determină tipul sesiunii. Modificaţi doar dacă doriţi un alt tip de sesiune decât cel
implicit (KDE). Viitoarele sesiuni sunt automat de acelaşi tip dacă nu se modifică în mod manual.
Menu Remote Login vă permite să faceţi login la un calculator aflat la distanţă.
Shutdown fie opreşte sistemul complet fie face reboot (repornirea sistemului).
Pentru a termina o sesiune alegeţi Logout din meniul principal. Puteţi decide apoi dacă să
încheiaţi sesiunea şi să lăsaţi sistemul mergând, să faceţi restart sau shut down la logout.

2. Utilizatorul de Linux
Linux face distincţia dintre un utilizator obişnuit şi un administrator. Administratorul, denumit root,
îndeplineşte activităţi specifice şi are acces la întregul sistem. Un utilizator normal nu are aceste
drepturi. Toţi utilizatorii au propriul lor director home în care se păstrază datele personale ca
documente sau poşta electronică. Drepturile de scriere sunt limitate strict la proprietarii
respectivi. Fişierele dintr-un director home care conţin date importante pot fi protejate la citirea
de către alţi utilizatori.
Directoarele de sistem care conţin fişiere de configurare a sistemului sau fişiere executabile pot
fi modificate doar de un administrator. Acest lucru este important pentru securitatea sistemului.
Un utilizator fără drepturi de root nu poate acţiona la nivelul întregului sistem, astfel încât
eventualele pierderi sau alterări de date se vor înregistra, cel mult, la nivelul datelor personale.
Doar operaţiile executate de root poate altera întregul sistem. Acesta este şi motivul pentru care
este mult mai greu de creat viruşi informatici pentru sistemele Linux, infectarea sistemului
neputându-se face decât de cel care deţine drepturi de administrator, deci implicit cunoaşte
parola.
În afară de posibilitatea creării de administratori şi de utilizatori obişnuiţi, Linux permite mai
multor utilizatori să lucreze simultan pe acelaşi calculator. Aceştia se pot conecta la sistem prin
diferite terminale sau prin conexiuni de reţea.

3. Desktop
SUSE LINUX oferă mai multe posibilităţi pentru desktop. GNOME şi KDE, care sunt cele mai
importante, au funcţiuni asemănătoare cu interfeţele grafice din Microsoft Windows sau Mac OS.
Această secţiune vă prezintă funcţiunile mai importante ale modului grafic şi vă ajută să vă
familiarizaţi cu noul desktop.



Figura E.2.

3.1 Termeni referitori la desktop
Lista următoare introduce câţiva termeni folosiţi în contextul de desktop indiferent de sistemul de
bază.
desktop Suprafaţa de lucru sau mediul de lucru poartă numele de desktop. Mediul desktop
acoperă tot ecranul dar este mai mult decât un simplu fundal. Pe desktop se plasează iconiţe ale
aplicaţiilor mai des folosite pentru a fi accesate mai uşor.
panou (panel) Are forma de bară situată în partea de sus sau de jos a ecranului şi conţine
meniuri, bara de lansare rapidă a programelor, o zonă de notificare, aplicaţii de tip help (ajutor)
şi în cele mai multe cazuri afişează bara de lucru (taskbar) care în GNOME poartă numele de
listă de ferestre (window list). Panoul este proiectat pentru a asigura toate informaţiile importante
necesare pentru a rula aplicaţii pe sistem şi pentru a oferi un acces uşor la anumite funcţii sau
aplicaţii importante. Atât GNOME cât şi KDE vă permit să modificaţi orientarea panoului (vertical
sau orizontal), în funcţie de nevoile utilizatorului. Într-un mediu KDE puteţi întâlni cuvântul
“Kicker” în loc de panou.
buton de meniu (menu button) Similar cu butonul de start, start button din mediul grafic
MSWindows, şi desktop-ul Linux conţine în mod normal un buton de meniu în partea din stânga
a panoului care deschide meniul principal. Acest meniu este o structura ordonată pentru accesul
la principalele funcţii şi aplicaţii ca Search (Căutare), Logout (Deconectare) şi Lock Session
(blocare sesiune).
bara de lucru (taskbar sau window list) Bara de lucru se foloseşte pentru a trece de la o
fereastră deschisă la alta. Pe taskbar sunt de asemenea prezente toate mediile grafice virtuale
disponibile cu posibilitatea de a comuta între ele.
bara de lansare rapidă (quick launcher) Bara de lansare rapidă este o parte a panoului. Ea
conţine icoane ale celor mai importante funcţii şi aplicaţii care vă permit să le porniţi fără să mai
treceţi prin meniul aplicaţii.
zona de notificări (notification area sau system tray) Partea din extremitatea dreaptă a
panoului care conţine ceasul sistemului, controlul de volum şi alte câteva aplicaţii de ajutor.
applet Un applet este o un program de mici dimensiuni care este integrat în panou.O aplicaţie
este un program de calculator independent care rulează într-o fereastră proprie pe ecran.
icoane sau pictograme (desktop icons) Icoanele sunt situate pe desktop. Ele reprezintă
fişiere, directoare, aplicaţii sau funcţii şi dispozitive ca CD-uri sau DVD-uri. Un exemplu de
icoană este coşul de gunoi (trash bin) în care se aruncă fişierele pe care dorim să le ştergem.



desktop virtual sau spaţii de lucru (virtual desktops, workspaces) Conceptul de desktop
virtual este similar cu a avea mai multe mese de birou. Păstraţi lucruri pe fiecare din ele dar
lucraţi doar la una dintre ele odată. Spaţiile de lucru vă dau posibilitatea să deschideţi mai multe
ferestre în acelaşi timp, fiecare cu un proces diferit. Trecerea de la o fereastră la alta se face cu
uşurinţă cu un comutator al spaţiului de lucru prezent atât pe panoul GNOME cât şi la KDE.
terminal Un terminal vă permite să trimiteţi comenzi sistemului de operare. Există terminale
fizice cum sunt monitorul şi tastatura conectate la calculator. Există de asemenea terminale
emulate care rulează într-o fereastră de pe desktop şi care afişează o linie de comandă de unde
se pot introduce comenzi către sistemul de operare.
sesiune (session) După logarea dumneavoastră la desktop, începe sesiunea de lucru. Ea
rămâne deschisă până când vă deconectaţi cu log out. O sesiune include pornirea şi oprirea
anumitor programe în urma comenzilor de login respectiv logout. Aceste setări pot fi configurate
individual pentru fiecare cont de utilizator.

3.2 Configurarea componentelor din desktop
Aproape toate componentele din desktop pot fi configurate individual. Un click dreapta pe
elementul respectiv deschide un meniu de context.

Configurarea componentelor desktop-ului GNOME
Procedura 1.1: Adăugarea unei aplicaţii noi în secţiunea de lansare rapidă (Quick Launch
Area)
1. Daţi click dreapta pe o porţiune liberă din panoul unde doriţi să adăugaţi noul program.
2. Alegeţi Add to Panel din meniul care apare.
3. Selectaţi Application Launcher din meniul Add to Panel.
4. Selectaţi aplicaţia din meniul Applications şi ieşiţi din configuraţie.

Procedura 1.2: Schimbarea fundalulul din desktop (Desktop Background)
1. Click dreapta pe desktop.
2. Alegeţi Change Desktop Background din meniul care apare.
3. Apare o fereastră de dialog care oferă mai multe opţiuni privitoare la desktop.
Fie selectaţi un wallpaper (tapet) cu mouse-ul fie daţi click pe Add pentru a deschide un dialog în
care se poate adăuga propria imagine. Utilizaţi Style pentru a determina cum să fie prelucrată
imaginea pentru dimensiunile ecranului. Utilizaţi Remove pentru a înlătura un background din
meniu. Dacă nu doriţi nici o imagine, setaţi o culoare de desktop.
4. Modificările se aplică automat. Închideţi dialogul cu Close.

Procedura 1.3: Crearea unei icoane noi pe desktop
1. Adăugaţi o nouă aplicaţie sau icoană de service (numită Launcher în GNOME):
(a) Click dreapta pe desktop pentru a deschide meniul context.
(b) Selectaţi Create Launcher pentru a deschide dialogul.
(c) Introduceţi numele (Name), numele generic (Generic Name), un comentariu opţional
(Comment) şi comanda (Command) pentru execuţie. Determinaţi dacă aplicaţia trebuie să
ruleze într-un terminal şi verificaţi că Type este setat la valoarea potrivită care este Application în
cazul comenzilor.
(d) Validaţi setările şi ieşiţi din dialog cu OK.
2. Adăugarea unui folder sau document nou:
(a) Click dreapta pe desktop pentru a deschide meniul context.
(b) Selectaţi Create Folder sau Create Document pentru a adăuga un articol nou pe desktop.
(c) Click dreapta pe noua icoană şi selectaţi Properties.
(d) Introduceţi numele noului obiect în caseta Basic. Selectaţi o icoană potrivită în caseta
Emblems. La  sfârşit se introduc permisiunile din sistemul de fişiere utilizând fila Permissions.
(e) Închideţi dialogul Properties pentru a aplica schimbările.

Configurarea componentelor KDE Desktop



Procedura 1.1: Adăugarea unei aplicaţii noi în Quick Launch Area
1. Click dreapta pe o porţiune liberă din panou unde doriţi să adăugaţi noua aplicaţie.
2. Alegeţi Add->Application Button din meniul care apare.
3. Selectaţi aplicaţia dintr-una din categoriile sub-meniului.

Procedura 1.2: Schimbarea  fundalului (Desktop Background)
1. Click dreapta pe desktop.
2. Alegeţi Configure Desktop. Se deschide un dialog care permite modificarea setărilor din
desktop Background, Behavior, Multiple Desktops, Screen Saver şi Display.
3. Alegeţi Background şi stabiliţi dacă setările se aplică unui desktop specific sau tuturor.
Selectaţi o imagine de background, dezactivaţi imaginile de background sau porniţi o prezentare
de diapozitive.
4. Aplicaţi modificările şi ieşiţi din dialog cu OK.

Procedura 1.3: Crearea unei noi iconiţe pe desktop
1. Adăugaţi o nouă icoană de folder :
(a) Click dreapta pe desktop pentru a deschide meniul context.
(b) Selectaţi Create-> NewFolder.
(c) Introduceţi numele noului folder.
(d) Click dreapta pe noua icoană şi selectaţi Properties din meniul care apare.
(e) Dialogul Properties are patru casete: General, Permissions, Meta Info şi Share. Numele şi
icoana folder-ului sunt setate în fila General. Permisiunile sunt modificate în fila Permissions.
Meta Info listează dimensiunea şi numărul articolelor din folder. Share se foloseşte la
configurarea partajării fişierului prin NFS sau Samba.
(f) Aplicaţi modificările şi ieşiţi din dialog cu OK.
2. Adăugaţi o nouă icoană de fişier:
(a) Click dreapta pe desktop din meniul care apare.
(b) Selectaţi Create New.
(c) Alegeţi tipul fişierului: HTML File (fişier HTML), Link to Application (link către aplicaţie), Link
to Location (link către locaţie) sau Text File (fişier text).
(d) Introduceţi numele noului fişier.
(e) Click dreapta pe icoană şi selectaţi Properties din meniu.
(f) Dialogul Properties are trei secţiuni: General, Permissions şi Meta Info. Numele şi icoana
fişierului sunt setate în fila General. Permisiunile sunt modificate în fila Permissions. Meta Info
listează numărul de linii, cuvinte, caractere şi formatul noului fişier.
(g) Aplicaţi modificările şi ieşiţi din dialog cu OK.
3. Adăugaţi o nouă icoană de dispozitiv:
(a) Click dreapta pe desktop pentru a deschide meniul context.
(b) Selectaţi Create New-> Link to Device.
(c) Alegeţi tipul de dispozitiv corespunzător pentru a deschide dialogul Properties.
(d) Dialogul Properties are secţiuni: General, Permissions, Device şi Meta Info.
Setaţi numele şi icoana dispozitivului în fila General. Modificaţi permisiunile în fila Permissions.
Fila Device se utilizează pentru a seta calea dispozitivului, ca de ex.  /media/dvd pentru o unitate
de DVD.
(e) Aplicaţi modificările şi ieşiţi din dialog cu OK.

3.3 Schimbarea utilizatorilor
Atât GDM cât şi KDM vă permit să treceţi de la un cont de utilizator la altul pe acelaşi sistem.
Puteţi fi conectat în timp ce alţi utilizatori lucrează pe sistemul dumneavoastră. Sesiunea este
„blocată” atunci când treceţi la alt cont dar aplicaţiile dumneavoastră continuă să ruleze.

Schimbarea utilizatorilor în GNOME
Pentru a deschide o sesiune adiţională pentru un alt utilizator, selectaţi New Login din meniul
Applications al lui GNOME. Utilizatorul introduce numele şi parola în GDM şi porneşte o nouă



sesiune GNOME. Sesiunea iniţială se încuie automat. Pentru a reveni în sesiunea de origine se
utilizează combinaţia de taste Ctrl+Alt+F7.
Notă:
Sesiunea originală porneşte pe consola grafică şi poate fi restabilită cu Ctrl+Alt+F7. Sesiuni
adiţionale pot fi stabilite cu ajutorul tastelor funcţionale F8, F9, etc.

Schimbarea utilizatorilor în KDE
Deschideţi o sesiune adiţională în KDE din meniul principal. Selectaţi Switch User şi stabiliţi
dacă sesiunea originală va fi blocată la comutarea într-un alt cont de utilizator. KDM vă va cere
numele de utilizator şi parola pentru noul cont. Introduceţi datele şi o nouă sesiune KDE va fi
iniţiată. Pentru a reveni în sesiunea originală daţi click din nou pe Switch User. Selectaţi
sesiunea în care veţi intra.

4. Gestionarea fişierelor
O parte centrală a mediului desktop este aplicaţia file manager, care vă permite să creaţi, să
accesaţi şi să gestionaţi fişierele din sistem.

4.1 Sistemul de fişiere Linux
În Linux toate fişierele şi directoarele sunt ierarhizate într-o structură arborescentă. Directorul de
pe nivelul cel mai sus este denumit rădăcina (root) sistemului de fişiere sau /. Toate celelalte
directoare se pot accesa de aici.
O scurtă prezentare a arborelui de fişiere Linux cu cele mai importante directoare:
/home/<numeutilizator> /home conţine datele personale ale fiecărui utilizator care are un cont
în sistem. Fişierele situate aici pot fi modificate doar de către proprietar sau de administratorul
de sistem. De exemplu, directorul de e-mail al utilizatorului este localizat aici.
/media /media conţine în general orice tip de drive cu excepţia discului hard din sistem. USB
flash drive apare în  /media odată ce a fost conectat, la fel ca şi o cameră digitală care foloseşte
USB, sau o unitate DVD sau CD. Îndată ce sursa de date a fost deconectată (USB flash sau
camera digitală), directorul respectiv este îndepărtat.
/usr/share/doc În /usr/share/doc se găseşte documentaţia referitoare la sistemul Linux şi la
pachetele instalate.
/windows Dacă pe sistem aveţi instalate atât MS Windows cât şi Linux, aici se găsesc datele
din MS Windows.

4.2 File Manager
Aceste module fac parte din desktop-ul standard.
Home Directory Utilizaţi icoana Home din GNOME sau căsuţa din panoul KDE pentru a lansa
un manager de fişiere (Nautilus în GNOME, Konqueror în KDE) care afişează conţinutul
directorului home.
Sistemul dumneavoastră. Dacă vreţi să ştiţi ce discuri sunt conectate în sistem daţi click pe
icoana Computer (GNOME) sau My Computer (KDE). Managerul de fişiere vă prezintă toate
unităţile ataşate în sistem, inclusiv discurile hard.
Reţeaua dumneavoastră. Utilizaţi meniul Places din panoul GNOME pentru a accesa folderele
de reţea. În KDE, daţi click pe icoana Network Browsing de pe desktop pentru a vedea toate
serviciile din reţea. Se utilizează pentru accesul la reţelele Windows, servere FTP sau orice alt
serviciu din reţea.

4.3 Căutarea fişierelor
În GNOME, selectaţi Places-> Search for Files pentru a lansa utilitarul de căutare. Specificaţi
numele fişierului sau o parte a lui şi directorul în care să se efectueze căutarea. Pentru o căutare
în întreg sistemul de fişiere se introduce /.
KDE conţine aplicaţia KFind, care este lansată din meniul principal cu Find Files. Se vor
introduce numele fişierului şi calea de căutare.



5. Aplicaţii
SUSE LINUX vine cu o mulţime de aplicaţii. Există trei moduri de lansare a unei aplicaţii în
Linux. Cel mai simplu este din meniul principal din mediul desktop. Daţi click pe marginea cea
mai din stânga a panoului pentru a desfăşura meniul. Selectaţi categoria potrivită pentru a
deschide un sub-meniu cu numele şi icoanele aplicaţiilor.
Unele aplicaţii nu apar în meniul principal deşi sunt instalate în sistem. Pentru a lansa o
asemenea aplicaţie se deschide meniul principal şi se selectează Run Application (GNOME) sau
Run Command (KDE) şi se introduce numele aplicaţiei cu litere mici. Ca o alternativă începeţi
acest dialog cu tastele Alt+F2.
A treia posibilitate de lansare a unei aplicaţii este de a deschide o fereastră terminal şi de a
introduce comanda din shell prompt sau linia de comandă.

6. Desktop-ul GNOME
Acest capitol prezintă desktop-ul GNOME (GNU Network Object Model Environment) trecând în
revistă cele mai importante elemente şi funcţionalităţi inclusiv managerul de fişiere Nautilus.

6.1 Desktop
Cele mai importante elemente ale desktop-ului GNOME sunt icoanele de pe desktop, panourile
de la marginea de sus şi de jos a ecranului şi meniurile. Mouse-ul este cel mai important
instrument deşi GNOME are suport tehnic şi pentru utilizatorii cu handicap (braille, sintetizatoare
de vorbire şi tastaturi pe ecran).

6.1.1 Icoanele
Un desktop standard prezintă cel puţin următoarele icoane de bază pentru funcţiunile sistemului:
Trash (cutia de gunoi) Obiectele şterse de utilizator ajung aici. Cât timp se regăsesc aici,
acestea nu sunt şterse permanent, putând fi recuperate.
Home (casă, domiciliu) Icoana Home vă permite un acces uşor la datele personale.
Computer Icoana Computer se foloseşte pentru un acces uşor la orice dispozitiv ataşat la
calculator. Acestea includ discuri hard, partiţii, camere digitale şi memorii USB.
Dând click dreapta pe o icoană se afişează un meniu din care pot fi selectate diferite acţiuni cu
privire la fişiere: copiere (copy), tăiere (cut) şi redenumire (rename). Selectând opţiunea
Properties din meniu se deschide un dialog de configurare. Accesând opţiunea Permissions
puteţi vizualiza şi modifica drepturile de acces, citire şi scriere a fişierului respectiv pentru
utilizatorul respectiv, grupuri de utilizatori sau restul utilizatorilor. Meniul pentru Trash conţine şi
opţiunea Empty Trashcan prin care folderul respectiv este golit. O icoană se şterge de pe
desktop prin mutarea ei în Trashcan. Prin mutarea icoanelor folderelor sau fişierelor în
Trashcan, datele conţinute de acestea sunt şterse.

6.1.2 Meniul Context
Dând click dreapta pe un spaţiu liber al desktop-ului este afişat un meniu cu diverse opţiuni.
Selectaţi New Folder pentru a crea un folder nou. Icoana de lansare a unei aplicaţii este creată
cu ajutorul opţiunii New Launcher. Introduceţi numele aplicaţiei şi comanda de pornire apoi
alegeţi o icoană care să reprezinte aplicaţia respectivă. Ordinea şi alinierea icoanelor de pe
desktop sunt controlate prin Clean Up by Name şi Keep Aligned. Este posibil să se schimbe
fundalul de desktop sau să se revină la setarea iniţială. Dacă este necesar un mediu cu linie de
comandă, daţi click pe Open Terminal.

6.1.3 Panourile
La prima conectare (login), desktop-ul GNOME porneşte cu două panouri localizate în partea de
sus şi de jos a ecranului. Ecranul de sus are trei meniuri (Applications, Places şi Desktop), o
zonă de lansare rapidă cu butoane pentru cele mai importante programe, o bară cu icoane
applet şi o parte de notificare cu ceasul sistemului şi controlul de volum.



Panoul de jos conţine icoane fereastră ale tuturor aplicaţiilor pornite din bara de instrumente.
Dacă se face click pe numele unei ferestre de pe bară, ea se mută în prin-plan (în foreground).
Dacă programul este deja în foreground) dând click pe el, acesta este minimizat. Dând click pe o
aplicaţie minimizată se redeschide respectiva fereastră.
Pe lângă bara de lucru, Workspace Switcher (comutatorul de spaţii de lucru) oferă suprafeţe de
lucru suplimentare. Aceste desktop-uri virtuale asigură spaţiu pentru a aranja aplicaţiile şi
ferestrele deschise. De exemplu, se plasează un editor într-un spaţiu, un shell într-altul şi
aplicaţia de e-mail şi Web browser-ul în a treia fereastră. Mutarea unei ferestre în alt spaţiu se
face deplasând icoana ei în workspace switcher dintr-un spaţiu în altul.

6.1.4 Meniul Applications
Acest meniu asigură un acces uşor la ierarhia de aplicaţii instalate în sistem. Cele mai multe
sunt grupate în sub-meniuri dedicate unei categorii ca System, Office şi Internet. Pentru a porni
o aplicaţie daţi click pe Applications, alegeţi categoria dorită, desfăşuraţi sub-meniul şi daţi click
pe numele aplicaţiei.
Programele care nu sunt în meniu pot fi iniţiate cu prompt-ul Run Application (Alt+F2), atunci
când cunoaşteţi comanda. De exemplu, dacă doriţi să vedeţi fotografii digitale şi nu găsiţi
comanda Thumb în meniu, introduceţi thumb din prompt-ul Run Application.

6.1.5 Meniul Places
Acest meniu asigură un acces comod la locaţii precum directorul home propriu, drive-uri, foldere
de desktop şi de reţea.

6.1.6 Meniul Desktop
Meniul conţine comenzile de bază pentru administrarea desktop-ului. Aici se găsesc Lock
Screen şi Log Out.

6.2 Administarea fişierelor cu Nautilus
Nautilus este managerul de fişiere din GNOME.
O fereastră standard Nautilus este prezentată în Figura E.3.

Figura E.3

Un folder se deschide dând dublu-click pe el, când va apare o fereastră care afişează conţinutul
acestuia.
Nautilus dispune şi de o interfaţă de tip browser. Daţi click dreapta pe folder şi alegeţi Browse
Folder. Se va deschide o nouă ferastră Nautilus cu aceleaşi funcţii, dar cu aspect de browser.
Navigarea prin foldere şi fişiere se face cu butoanele Back (înapoi), Forward (înainte) şi Up (sus)
la fel ca într-un browser de web.

Pentru deplasarea între foldere se foloseşte meniul derulant din colţul stânga-jos al ferestrei
Nautilus. Aici sunt toate folderele părinţi ai directorului curent până la rădăcina (root) sistemului



de fişiere. Selectaţi fişierul dorit şi el se deschide într-o fereastră nouă deasupra celei vechi.
Directorul părinte al folder-ului curent se deschide cu File->Open Parent. Dacă vreţi să închideţi
directoarele părinte selectaţi File->Close Parent Folders.

6.2.1 Managementul fişierelor
Nautilus suportă comenzi de tipul „drag and drop” pentru administrarea fişierelor. Orice fişier de
pe desktop poate fi tras dintr-o fereastră deschisă în Nautilus şi plasat la destinaţia finală.
Mutarea fişierelor între directoare se face prin deschiderea directorului sursă care conţine fişierul
ce trebuie mutat. Selectaţi File->Open Location, introduceţi calea către directorul destinaţie şi
trageţi fişierele care trebuie mutate în fereastra Nautilus ce conţine directorul destinaţie. Fişierele
şi folderele se pot muta şi între o fereastră Nautilus şi desktop.
Mai multe copii ale unui fişier se crează cu Edit->Duplicate. Operaţiile cut (tăiere), copy (copiere)
şi paste (lipire) se execută din meniul Edit sau cu click dreapta pe icoana fişierului şi selectarea
acţiunii din meniul context care apare. Redenumirea unui fişier se face dând click dreapta pe
acesta şi selectând Rename.
Nautilus suportă navigarea printre fişierele dintr-o reţea. Conectarea la server (FTP, SSH,
HTTP, Samba, etc.), se face cu ajutorul succesiunii File->Connect to Server. Se vor cere tipul de
server la care vă conectaţi, numele folderului de accesat, numărul portului şi numele
utilizatorului.  Dialogul se încheie cu Connect iar folderul din reţea este afişat ca parte a panoului
Places şi apare ca o icoană pe desktop. Închiderea conexiunii se face dând click dreapta pe
icoana de pe desktop şi selectând Unmount Volume.
Nautilus are posibilitatea de a scrie CD-uri. Dacă aţi creat un director care conţine datele de
back up pe CD, parcurgeţi succesiunea Places->CD Creator şi trageţi folderul care conţine
datele în fereastra CD/DVD Creator. Selectaţi File->Write to Disc pentru a copia datele pe CD
sau DVD.

7. KDE Desktop
Desktop-ul KDE oferă o interfaţă grafică intuitivă. Secţiunea următoare vă arată cum să utilizaţi
eficient acest mediu de lucru. Urmează o descriere a managerului de fişiere Konqueror cu o
prezentare a utilitarelor sale.

7.1 Componentele Desktop-ului
Principalele componente sunt icoanele de pe desktop şi un panou în partea de jos a ecranului.
Pornirea unui programul sau a managerului de fişiere Konqueror se face dând click pe simbolul
sau icoana asociată. Dacă daţi click dreapta pe o icoană apar meniuri diferite în funcţie de
program. În KDE sunt două meniuri de desktop.

7.1.1 Meniurile Desktop-ului
Dacă daţi click cu butonul din mijloc al mouse-ului pe desktop (la un mouse cu două butoane,
apăsaţi ambele butoane simultan), se deschide o fereastră şi un meniu de management al
desktop-ului.
Meniul afişează diferitele ferestre deschise în desktop-uri şi, de asemenea, următoarele opţiuni:

Unclutter Windows (aranjare ferestre) Dacă aveţi mai multe ferestre pe desktop, acestea vor
fi aranjate una lângă alta, aliniate în colţul din stânga sus.

Cascade Windows (ferestre în cascadă) Începând din colţul din stânga sus, ferestrele din
desktop sunt plasate una deasupra celeilalte astfel încât doar marginile de sus şi din stânga sunt
vizibile la ferestrele de dedesupt.

Desktop x Desktop 1 este desktop-ul implicit. Această parte din meniu listează toate ferestrele
deschise în prezent. Ele se pot aduce în faţă cu un click pe articolul respectiv.



Additional Desktops (desktop-uri suplimentare) Se pot utiliza desktop-uri suplimentare
(virtuale) şi comuta între ele din meniu sau din panou. Toate funcţiile sunt disponibile pe toate
desktop-urile.

Cu click dreapta pe desktop, se deschide un meniu mai complex:

Create New (creare nou) Utilizaţi acest meniu pentru a crea noi directoare, fişiere sau
dispozitive pe desktop. O listă a elementelor care pot fi create la acest nivel este disponibilă
pentru selecţie într-un sub-meniu.

Bookmarks (semne de carte) Un editor de bookmark poate crea, grupa, modifica sau şterge
un  bookmark. Browser-ul şi managerul de fişiere Konqueror folosesc bookmark-uri.

Run Se deschide o fereastră în care se poate introduce manual o comandă. Execuţia comenzii
se face cu tasta Enter.

Undo (anulare) Anulează ultima acţiune. De exemplu, dacă după ce aţi creat un director nou pe
desktop, daţi click pe această opţiune, directorul respectiv este îndepărtat din sistem.

Paste (lipire) Pentru a avea la îndemână pe desktop un document sau un folder se poate copia
icoana din file manager cu click dreapta, selectând Copy şi apoi plasând cursorul în locaţia
dorită de pe desktop şi alegând Paste din opţiunile care apar dând click dreapta.

Icons (Icoane) Rearanjează icoanele pe desktop.

Windows Aranjează ferestrele pe desktop, fie prin suprapunere, fie una lângă alta.

Refresh Desktop Restabileşte imaginea desktop-ului dacă acesta pare distorsionat.
Configure Desktop (configurere Desktop) Deschide o fereastră de dialog pentru configurarea
desktop-ului.
Start New Session (iniţiere sesiune nouă) Este deschisă o casetă de dialog în care utilizatorul
este îmtrebat dacă doreşte initierea unui nou mediu de utilizator. După ce daţi click pe Start New
Session, sesiunea curentă dispare în background şi sistemul afişează un nou ecran de logare.
Fiecare sesiune are o tastă funcţională asignată: F7 reprezintă prima sesiune, F8 a doua şi aşa
mai departe. Comutarea între sesiuni se face cu Ctrl+Alt+Fx, unde Fx este cheia funcţională
corespunzătoare sesiunii dorite.

Lock Screen (blocare ecran) Dacă plecaţi de lângă calculator fără a vă deloga, folosiţi această
funcţie pentru a-i împiedica pe ceilalţi să aibă acces la fişierele personale. Ecranul se şterge sau
afişează un screensaver. Pentru a relua lucrul introduceţi parola dumneavoastră.

Help (ajutor) Acest sub-meniu deschide manualul KDE.

Logout (delogare) Dacă nu mai folosiţi sistemul selectaţi log out.

7.2 Setări
Desktop-ul KDE poate fi personalizat după preferinţe şi necesităţi.
Control Center din meniul principal deschide dialogul de configurare pentru KDE desktop. Se
poate porni şi cu comanda kcontrol.
Control Center are meniurile în partea de sus a ecranului şi o bară laterală în partea stângă.
Configuraţia este afişată în partea din dreapta.

7.3 Managerul de fişiere Konqueror
Konqueror este un browser de web, un manager de fişiere, permite vizualizarea documentelor
(document viewer) şi a imaginilor (image viewer).
Porniţi Konqueror dând click pe icoana „house” (casă) din panou sau apăsând tastele Alt+F2
şi intrând în konqueror $HOME. Se afişează conţinutul directorului home propriu. Fereastra
managerului de fişiere constă din bara de meniuri din partea de sus a ecranului, bara de



instrumente şi bara de locaţie. Partea de jos a ecranului este despărţită vertical în panoul de
navigaţie şi fereastra principală care afişează conţinutul.

Figura E.4.

7.3.1 Meniul  Konqueror
Location (locaţie) Location deschide ferestre suplimentare Konqueror. Dacă daţi click pe New
Window directorul home propriu este afişat într-o fereastră nouă. Duplicate Window produce o a
doua fereastră cu acelaşi conţinut.
Edit (editare) Opţiunile din Edit devin active dacă selectaţi un obiect din fereastra principală. În
afară de funcţiile standard de editare cut (tăiere), copy (copiere), paste (lipire), rename
(redenumire), move (mutare) şi delete (ştergere), mai există funcţia Create New (creare nou)
care se poate folosi pentru a crea directoare, fişiere şi dispozitive.
View (vedere) Meniul View schimbă modul de vizualizare. Dacă un director conţine mai multe
fişiere atunci o vizualizare sub formă de text sau de arbore poate fi mai eficientă. Pentru pagini
în format HTML, se activează Use index.html. Dacă un director conţine un fişier cu acest nume,
Konqueror îl încarcă şi îl afişează.
Go (salt la) Meniul Go conţine funcţiile de navigaţie Up, Back, Forward şi Home Page. Totuşi
aceleaşi funcţii pot fi accesate mai repede şi mai convenabil din bara de instrumente (toolbar).
Bookmarks (semne de carte) Bookmarks se foloseşte pentru a păstra adrese de Internet
(URL-uri) şi căi spre fişierele sau directoarele din sistem. Din motive practice bookmark-urile se
aranjează în foldere.
Tools (instrumente) Acest meniu include o varietate de funcţii ca Run Command (execută
comanda),Open Terminal Window (deschidere fereastră terminal) şi Find Files (căutare fişiere).
Settings (setări) Meniul Settings se foloseşte pentru configurarea aspectului aplicaţiei
Konqueror. Sub-meniul Toolbars vă permite să ascundeţi sau să afişaţi elementele acestuia.
Window (fereastră) Meniul Window permite împărţirea ferestrei principale pe orizontală sau
verticală.
Help (ajutor) Meniul Help apelează manualul Konqueror sau funcţia What’s This (ce este
aceasta). În mod normal, funcţia poate fi accesată cu simbolul ? din bara de titluri. Prompt-ul
este afişat ca un semn de întrebare. Dacă daţi click pe o icoană se afişează un text scurt de
ajutor dacă este disponibil.

7.3.2 Bara de instrumente (Toolbar)
Bara de instrumente asigură un acces rapid la funcţii frecvent utilizate care pot fi accesate de
asemenea din meniu.



7.3.3 Bara de locaţie
Bara de locaţie este precedată de un simbol negru cu un X alb. Dacă daţi click pe această
icoană se şterge conţinutul liniei, permiţând introducerea unei locaţii noi. O locaţie poate fi
specificarea unei căi cum este cea care apare când se afişează directorul home sau adresa unei
pagini web. După ce s-a introdus adresa, se apasă Enter sau se dă click pe Go din dreapta
liniei.

7.3.4 Fereastra principală
Fereastra principală afişează conţinutul directorului selectat. Dacă daţi click pe o icoană,
respectivul fişier este afişat în Konqueror sau încărcat în aplicaţia corespunzătoare pentru o
prelucrare ulterioară.
Dacă se dă click dreapta pe o icoană se deschide un meniu. Acesta depinde de tipul fişierului şi
oferă acţiuni cum sunt Cut, Copy, Paste şi Delete. Utilizaţi Open with pentru a selecta dintr-o
listă de programe aplicaţia cu care să se deschidă fişierul.
Cel mai rapid mod de a efectua diferitele acţiuni este metoda „drag and drop”, de exemplu,
mutarea fişierelor dintr-o fereastră Konqueror într-alta se face trăgându-le în timp ce se ţine
apăsat butonul stânga al mouse-ului. Veţi fi întrebat dacă respectivele obiecte trebuie să fie
mutate sau copiate.



8. Office

8.1 Suita OpenOffice.org
OpenOffice.org este un set puternic de programe de birou care oferă instrumente pentru toate
lucrările de birou ca scrierea de texte, calcul tabelar, lucrări de grafică şi prezentări.
OpenOffice.org, este compatibil cu cu cele mai utilizate formate pentru documente:

• MS Office, de la versiunea 6.0 până la cea prezentă
• RTF (Rich Text Format)
• StarWriter
• HTML (Hyper Text Markup Language)
• PDF (Portable Document Format)

Se pot deschide şi edita fişiere în format Microsoft Office şi apoi salvate în acelaşi format dacă
este necesar. Acest capitol prezintă doar noţiuni de bază pentru a începe lucrul cu
OpenOffice.org. Porniţi aplicaţia din meniul SUSE sau folosind comanda ooffice.
OpenOffice.org constă din mai multe module (subprograme), proiectate să interacţioneze unele
cu altele. O descriere completă a fiecărui modul se găseşte în ajutorul online.

Modulele de aplicaţii OpenOffice.org

Writer Aplicaţie procesor de texte
Calc Aplicaţie calcul tabelar cu un utilitar pentru grafice
Draw Aplicaţie de desen pentru grafică vectorială
Math Aplicaţie de formule matematice
Impress Aplicaţie pentru crearea de prezentări
Base Aplicaţie pentru baze de date

8.1.1 OpenOffice.org Writer
Acest procesor de text este asemănător cu un editor de text având în plus posibilitatea de a
formata, proiecta şi tipări documente fără a fi necesar să se memoreze combinaţii complexe de
coduri.
OpenOffice.org Writer este un procesor de text puternic cu formatare de tipul WYSIWYG- ceea
ce se vede pe ecran este şi ceea obţineţi dacă tipăriţi sau dacă distribuiţi documentul.
Puteţi deschide OpenOffice.org Writer fie din Applications selectând Applications-> Office->
OpenOffice.org Writer, fie din shell prompt cu comanda oowriter.
Când se deschide OpenOffice.org Writer aveţi în faţă un document gol. Marginile documentului
sunt reprezentate de un chenar desenat pe ecranul principal. Se poate începe imediat
introducerea textului.

Notă
Se poate observa că pe măsură ce introduceţi textul că OpenOffice.org Writer completează
restul cuvântului. Acest text auto-completat este subliniat. Dacă acceptaţi terminaţia cuvântului
apăsaţi tasta Enter. Dacă nu este cuvântul dorit, continuaţi să tastaţi normal. Se poate dezactiva
această funcţie din Tools->Autocorrect/AutoFormat. Se deschide o casetă de dialog. Daţi click
pe fila Word Completion şi deselectaţi caseta Enable Word Completion.



Pentru a crea un fişier nou în  OpenOffice.org Writer:
1. Urmaţi succesiunea File->New->Text Document sau daţi click pe icoana New document din
partea stânga-sus a ecranului (butonul săgeată din partea dreapta-sus a icoanei vă permite să
selectaţi tipul de document pe care doriţi să îl creaţi)
2. Începeţi introducerea textului

Figura E.5.

Pentru a deschide un fişier existent:

1. Apelaţi succesiunea File->Open şi daţi click pe icoana folder-ului sau apăsaţi Ctrl+O.
2. Se deschide o fereastră browser.
3. Folosiţi icoanele de navigare din partea dreapta-sus a ecranului sau daţi click pe folderele din
    fereastra panou pentru a găsi fişierul pe care doriţi să-l deschideţi.
4. Fie daţi dublu click pe fişier, fie daţi un click pe el şi apoi daţi click pe butonul Open pentru a
deschide fişierul.

Pentru a salva un fişier:

1. Daţi click pe icoana reprezentând o dischetă, , sau în meniul File (Fişier) apelaţi la
opţiunea Save (Salvare), sau Save As (Salvare ca).
2. Se deschide o fereastră care afişează sistemul de fişiere. Dacă fişierul a fost salvat înainte nu
mai trebuie să faceţi nimic.
3. Dacă fişierul nu a mai fost salvat sau doriţi să-l salvaţi sub un alt nume sau/şi în altă locaţie
sau/şi cu o altă extensie, alegeţi opţiunea Save As (Salvare ca). Deplasaţi-vă în locaţia unde
vreţi să salvaţi fişierul.
4. Introduceţi un nume pentru fişier în câmpul File name.
5. Selectaţi formatul pentru fişier din meniul File type.
6. Daţi click pe butonul Save.



Notă
Pentru a salva un document într-un format diferit de formatul implicit al OpenOffice.org Writer
şi care este de tip .sxw, trebuie să selectaţi tipul fişierului din lista File type. Dacă se selectează
caseta Automatic file name extension, OpenOffice.org Writer va adăuga în mod automat
extensia corectă (.doc sau .txt) la sfârşitul numelui de fişier. Dacă nu se alege un tip de fişier din
lista derulantă, OpenOffice.org Writer îl va salva în formatul său implicit, chiar dacă aţi introdus
extensia dorită pentru fişier.
Pentru a salva documentul ca un fişier de tip .pdf apelaţi succesiunea File->Export as pdf. Cu
toate că OpenOffice.org Writer poate salva un fişier cu extensia .pdf, el nu poate să-l citească
sau să-l editeze. Pentru a vizualiza un fişier .pdf file, vedeţi FIXME.

Pentru a imprima un document:

1. Daţi click pe icoana reprezentând o imprimantă, , apelaţi succesiunea File->Print sau
apăsaţi simultan tastele Ctrl şi P.
2. Se deschide o fereastră cu opţiuni de configurare.
3. Selectaţi opţiunile dorite.
4. Daţi click pe butonul OK.

Pentru a vedea un fişier înainte de tipărire:

1. Apelaţi succesiunea File->Page Preview.
2. Se deschide o nouă fereastră în care puteţi vizualiza fişierul dumneavoastră.

3. Examinaţi documentul cu ajutorul instrumentului de mărit (zoom), reprezentat de icoana 
sau folosind icoanele de pagină din stânga-sus .
4. Puteţi tipări din acest ecran la fel ca şi din ecranul principal.
5. Când aţi terminat examinarea documentului, daţi click pe butonul Close Preview pentru a vă
    întoarce în meniul principal.

Pentru a schimba formatul textului:

1. Selectaţi textul pe care vreţi să-l formataţi.
2. Fie aplicaţi un stil pentru text cu Stylist (vezi FIXME) sau
3. Alegeţi opţiuni de formatare din bara de instrumente ca de exemplu: bold (aldine), alignment
(aliniere), line spacing (distanţa dintre linii), font color (culoare font), etc.

Pentru a adăuga o listă în text:

1. Fie selectaţi textul pe care doriţi să-l formataţi ca listă, fie mutaţi cursorul pe linia unde doriţi
să înceapă lista.
2. Daţi click fie pe icoana Numbering  fie pe icoana Bullets .
3. Pentru un text existent, lista se va crea şi se va formata automat. Pentru un text nou,
introduceţi fiecare articol şi apăsaţi tasta Enter.
4. Pentru ieşirea din listă, apăsaţi tasta Enter de două ori.

Pentru a formata o pagină:

1. Parcurgeţi succesiunea Format->Page.
2. Se deschide o fereastră cu diferite opţiuni de formatare a paginii. Fila Page vă ajută să
schimbaţi marginile paginii.
3. Selectaţi opţiunile de formatare pentru pagină.
4. Daţi click pe butonul OK pentru a aplica aceste modificări.



Pentru a anula modificările:

1. Daţi click pe icoana Undo, , sau parcurgeţi succesiunea Edit->Undo, sau apăsaţi simultan
tastele Ctrl şi Z.
2. Dând click pe săgeata din partea dreapta-sus a icoanei Undo va fi afişată o listă a acţiunilor
anterioare. Alegerea uneia dintre ele anulează toate acţiunile înapoi până în acel punct.

8.1.2 OpenOffice.org Calc
OpenOffice.org Calc funcţionează similar altor aplicaţii de tip foaie de calcul tabelar.

Pentru a crea o nouă foaie de calcul:

1. Porniţi OpenOffice.org Calc din meniul Applications: selectaţi Application->Office->
OpenOffice.org Calc sau introduceţi oocalc ca linie de comandă.
2. Introduceţi text, numbers (cifre) sau functions (funcţii).

Pentru a deschide o foaie de calcul existentă:

1. Deschideţi OpenOffice.org Calc, apelaţi succesiunea File->Open, daţi click pe icoana Folder,
sau apăsaţi simultan tastele Ctrl şi O.
2. Vă deplasaţi în locaţia foii de calcul.
3. Dublu-click pe numele foii de calcul sau un click pentru a o selecta şi apoi daţi click pe butonul
OK.

Pentru a salva o foaie de calcul:

1. Daşi click pe icoana reprezentând o dischetă, , sau în meniul File alegeţi fie Save, fie Save
As.
2. Se deschide o fereastră în care este afişat sistemul de fişiere. Dacă fişierul a mai fost salvat
înainte nu mai trebuie să faceţi nimic.
3. Dacă fişierul nu a mai fost salvat sau doriţi să-l salvaţi sub un alt nume sau/şi în altă locaţie
sau/şi cu o altă extensie, alegeţi opţiunea Save As (Salvare ca). Deplasaţi-vă în locaţia unde
vreţi să salvaţi fişierul.
4. Introduceţi un nume pentru fişier în câmpul File name.
5. Selectaţi formatul pentru fişier din lista File type.
6. Daţi click pe butonul Save.

Pentru a imprima o foaie de calcul:

1. Daţi click pe icoana reprezentând o imprimantă, , apelaţi succesiunea File->Print sau
apăsaţi simultan tastele Ctrl şi P.
2. Se deschide o fereastră cu opţiunile de configurare a imprimării.
3. Selectaţi opţiunile dorite.
4. Daţi click pe butonul OK.

Pentru a introduce manual o funcţie:

1. Selectaţi celula unde doriţi să plasaţi funcţia.
2. Introduceţi semnul  "=", apoi numele funcţiei.
3. Dacă se doreşte definirea anumitor celule ca argumente ale funcţiei, acestea vor fi introduse
între paranteze simple prin selectarea cu ajutorul mouse-ului sau prin introducerea manuală a
identificatorului celulelor.
4. Apăsaţi tasta Enter pentru a introduce funcţia şi pentru a calcula rezultatul.



Pentru a introduce o funcţie folosind Function AutoPilot:

1. Selectaţi celula unde va fi introdusă funcţia.
2. Apelaţi succesiunea  Insert-> Function sau apăsaţi simultan tastele Ctrl şi F2.
3. Se deschide fereastra AutoPilot.
4. Selectaţi funcţia pe care vreţi să o folosiţi din panoul din stânga, dând dublu-click pe ea.
5. În panoul din dreapta se afişează informaţia despre funcţia selectată. Câmpurile de date sunt
chiar sub informaţia despre funcţie. În final rezultatul calculului apare într-un chenar.
6. Pentru a selecta celulele folosite de funcţie se dă click pe icoana Shrink (micşorare) situată
lângă câmpul în care vor fi introduse aceste celule.
7. Celulele se selectează cu mouse-ul. Apăsaţi tasta Enter pentru a vă întoarce în  AutoPilot.
8. Când aţi terminat daţi click pe butonul OK.

Pentru a folosi formatarea condiţională:

1. Apelaţi succesiunea Format->Conditional Formatting...
2. Se deschide o fereastră cu opţiunile de formatare.
3. Selectaţi dacă se aplică condiţia la o celulă sau la o funcţie din stânga ecranului.
4. Selectaţi condiţia relaţiei din meniul derulant.
5. În câmpul următor introduceţi o valoare sau selectaţi celule.
6. In meniul derulant Cell Style (stil celulă), selectaţi stilul pentru rezultat.

Pentru a modifica formatul celulelor:

1. Selectaţi celulele de modificat cu ajutorul mouse-ului.
2. Apelaţi la succesiunea Format->Cells şi selectaţi fila Borders (margini celulă) sau daţi click pe
icoana Borders aflată pe bara de instrumente Object Bar.
3. Din fila Borders, alegeţi culoarea, poziţia, grosimea şi tipul liniei de margine. Daţi click pe
butonul OK pentru a aplica aceste margini.
4. Săgeata din partea dreapta-sus a icoanei Borders deschide un meniu derulant. Daţi dublu
click pe imaginea care reprezintă marginile pentru a aplica selecţia.

Pentru a crea un grafic:

1. Selectaţi datele utilizate pentru grafic cu ajutorul mouse-ului.
2. Apelaţi la succesiunea Insert->Chart.
3. Se deschide fereastra AutoFormat Chart.
4. Selectaţi locaţia graficului şi daţi click pe butonul Next >>.
5. Alegeţi tipul de grafic şi daţi click pe butonul Next >>.
6. Alegeţi o alternativă şi daţi click pe butonul Next >>.
7. Introduceţi titlul graficului şi daţi click pe butonul Create.

8.1.3 OpenOffice.org Impress
OpenOffice.org Impress este o aplicaţie pentru prezentări. Ea permite utilizatorilor să creeze
diapozitive (slides) cu text şi grafică. Impress poate fi utilizat pentru a tipări diapozitive sau
pentru prezentări realizate cu ajutorul unui proiector.
Pentru a deschide Impress, apelaţi succesiunea Applications->Office->OpenOffice.org Impress.
Când porneşte aplicaţia, AutoPilot vă conduce prin set up-ul iniţial al prezentării de diapozitive.
Faceţi selecţiile şi daţi click pe butonul Create. Se deschide un slide gol în care puteţi edita
prezentarea.
1. Se descarcă sau se creează un nou şablon (template) pentru OpenOffice.org Impress.
2. Deschideţi fişierul în OpenOffice.org Impress.
3. În meniul File selectaţi Templates->Save.
4. Se deschide o fereastră. Introduceţi numele noului şablon şi daţi click pe butonul OK.
Pentru a utiliza un model nou:

1. În meniul File selectaţi New->Templates and Documents.



2. Se deschide o fereastră cu panouri care afişează directoarele cu şabloane în partea stângă şi
şabloanele din acele directoare în partea dreaptă. Căutaţi în folder-ul Default şabloanele pe care
le-aţi salvat.
3. Apăsaţi butonul OK.

Pentru a afişa pe ecran o prezentare:

1. În meniul Slide Show există mai multe opţiuni pentru a personaliza prezentarea
dumneavoastră, incluzând tipul de afişare, tranziţiile şi alte efecte.
2. Odată făcute alegerile, fie apelaţi la Slide Show->Slide Show, fie apăsaţi tasta F9.
3. Deplasarea prin diapozitivele din prezentare se face cu ajutorul mouse-ului sau folosind
tastele direcţionale.

8.1.4 OpenOffice.Org Draw
OpenOffice.org include un program de desen pentru crearea de vectori grafici. Poate fi accesat
din interiorul altor aplicaţii ale suitei OpenOffice.org sau ca aplicaţie separată.

Pentru a deschide OpenOffice.org Draw din altă aplicaţie:

1. În meniul File selectaţi Object->OLE Object.
2. Când se deschide fereastra Insert OLE Object, selectaţi butonul Create new from file (creare
nou din fişier), selectaţi OpenOffice.org Draw şi daţi clic pe OK.
3. OpenOffice.org Draw se deschide ca o fereastră în interiorul documentului.
4. Creaţi desenul cu instrumentele din bara de instrumente din stânga ecranului.
5. La terminare daţi click pe un document din afara ferestrei de desen. Desenul este inserat
acum în document.

Pentru a crea un desen cu OpenOffice.org Draw:

1. Porniţi aplicaţia fie selectând Applications->Office->OpenOffice.org Draw, fie introducând
comanda oodraw din shell prompt, fieinserând un desen din altă aplicaţie ca în exemplul de mai
sus.
2. Selectaţi un instrument din Main Toolbar (bara principală de instrumente) cu mouse-ul.
3. Selectaţi o alternativă la instrument dând click pe listă.
4. Mutaţi cursorul mouse-ului în pagina albă şi realizaţi desenul.

8.1.5 OpenOffice.org Math
OpenOffice.org Math este un instrument util pentru a crea funcţii care să fie importate în
oricare din modulele OpenOffice.org .
Notă:
Aceste funcţii nu pot fi importate pentru evaluare în  OpenOffice.org Calc.

Pentru a crea o funcţie:

1. Deschideţi OpenOffice.org Math fie selectând Applications->Office->OpenOffice.org
    Math, fie cu ajutorul comenzii oomath din shell prompt, fie inserând un OLE Object cum s-a
    descris în secţiunea de mai sus.
2. Selectaţi un tip de funcţie din jumătatea de sus a ferestrei Selection.
3. Selectaţi una din funcţiile din jumătatea de jos a ferestrei Selection.
4. Panoul de jos din fereastra principală conţine codul selecţiei. Variabilele funcţiei sunt
reprezentate de simbolurile ?>.
5. Înlocuiţi casetele cu variabile ştergând simbolurile ?> şi înlocuindu-le cu text.
6. Actualizaţi ecranul, dând un click în interiorul lui.
7. Pentru a grupa selecţiile folosiţi paranteze. OpenOffice.org Draw utilizează aceeaşi ordine a
    operaţiilor ca şi algebra.



8.1.6 Base
Creaţi o bază de date cu File->New->Database. Este iniţializat un program care vă asistă la
crearea bazei de date.
Base poate lucra şi cu bazele de date din Microsoft .
Se pot crea manual sau cu programe ajutătoare tabele, forme, interogări ale bazei de date şi
rapoarte. Bazele de date create în Base pot fi utilizate ca surse de date pentru a crea scrisori cu
forme incluse.

9. Evolution: Un program de e-mail şi  calendar
Evolution este un grup de programe pentru e-mail împreună cu liste de planificare a activităţilor
şi un calendar. Aplicaţia mai oferă şi o carte de adrese de e-mail.
Porniţi Evolution selectând Applications->Internet->Email sau cu comanda evolution.
Fereastra standard este prezentată în Figura 6.1. Meniurile disponibile, articolele din meniu şi
icoanele de pe bara de instrumente variază în funcţie de componenta deschisă. Utilizaţi panoul
din stânga pentru a selecta informaţia afişată în partea dreaptă. Dimensiunea panoului se
ajustează prin deplasarea cu mouse-ul a barelor despărţitoare.

9.1 Poşta electronică (Mail)
În această imagine, jumătatea de sus a ferestrei arată conţinutul folderului curent. Jumătatea de
jos este un panou în care se vizualizează mesajul de poştă selectat.
Căutarea mesajelor din folder se face cu ajutorul barei de căutare (search bar). Lista de mesaje
se poate sorta dând un click pe coloana după care din capul de tabel după care se doreşte
efectuarea sortării. Sortarea poate fi ascendentă sau descendentă după sensul săgeţii din
partea dreaptă. Daţi click pe coloană până când apare direcţia corectă.
Componenta Evolution mail poate lucra cu multiple conturi de mail şi într-o varietate de formate
de mail. Aplicaţia poate fi configurată din selectând opţiunea Preferences din meniul Edit.

Figura E.6.



9.1.1 Configurarea conturilor de mail
Evolution este capabil să aducă mesaje din conturi de mail multiple. Contul din care se trimite un
e-mail poate fi selectat atunci când se compune mesajul. Configuraţi conturile de mail selectând
Preferences->Mail Accounts din meniul Edit.
Pentru a modifica o configuraţie existentă, o selectaţi şi daţi click pe Edit.
Pentru a şterge un cont, îl selectaţi şi daţi click pe Delete.
Pentru a adăuga un cont nou daţi click pe Add (adăugare). Se deschide configuration assistant
(aplicaţie ajutătoare de configurare). Daţi click pe butonul Forward. Introduceţi numele şi adresa
de e-mail în câmpurile respective. Introduceţi informaţiile opţionale, dacă doriţi. Bifaţi Make this
my default account pentru a utiliza implicit acest cont atunci când scrieţi e-mail-uri. Daţi click pe
butonul Forward. Selectaţi formatul corect al e-mail-ului care se primeşte la această adresă în
rubrica Server Type (tip server).
POP (Post Office Protocol) se utilizează pentru a trimite mesajele de e-mail de pe serverul de
mail la client în folder-ul inbox, locul unde se păstrează poşta recepţionată. Mail-ul POP se
descarcă direct la client şi nu rămâne pe server în configurarea implicită. (Clienţii de mail pot fi
configuraţi ca mail-ul să mai rămână pe server.)
IMAP (Internet Message Access Protocol) este un protocol pentru regăsirea mesajelor de e-mail
de pe serverul de mail al furnizorului de servicii ISP. E-mail-ul de pe serverele IMAP se
păstrează pe server şi nu se descarcă la client.
Adresa serverului POP sau IMAP este de forma  mail.exemplu.com. Completaţi toate câmpurile
relevante care sunt afişate când se selectează tipul serverului.
Daţi click pe butonul Forward când aţi terminat.
Selectaţi opţiunile dorite pentru recepţie, Receiving Options. Daţi click pe butonul Forward.
Următorul set de informaţii se referă la trimiterea poştei. Selectaţi fie Sendmail pentru poşta care
pleacă din sistemul local, fie SMTP în cazul unui server de mail.
SMTP (Simple Mail Transfer Protocol) este un protocol pentru trimiterea de mesaje de e-mail
între servere de mail. Se utilizează de asemenea pentru a trimite mesaje de la clientul de mail la
serverul de mail.
Pentru SMTP, completaţi câmpurile afişate după selecţie. Daţi click pe butonul Forward când aţi
terminat.
O adresă de mail este de forma numeleutilizator@numededomeniu.com.
Adresa de e-mail este utilizată în mod implicit ca nume pentru a identifica un cont. Introduceţi un
alt nume dacă doriţi. Daţi click pe butonul Forward. Daţi click pe butonul Apply pentru a salva
configuraţia contului.
Un cont se poate declara cont implicit de trimitere de e-mail dacă selectaţi contul dorit şi apăsaţi
Default. Dezactivarea unui cont se face dând click pe Disable. Un cont dezactivat poate fi folosit
pentru a trimite mail dar nu mai primeşte mesaje. Reactivarea contului se face selectând Enable.

9.1.2 Crearea de mesaje
Pentru a scrie un mesaj apelaţi la succesiunea New->Mail Message. Când se răspunde (reply)
sau se redirecţionează un mesaj (forward) se deschide acelaşi editor de mesaje. Lângă rubrica
From, selectaţi din ce cont trimiteţi mesajul. Introduceţi adresa de e-mail a destinatarului în
câmpul To. Pentru a selecta adresa din agenda de adrese (address book), daţi click pe To sau
CC (Carbon copy: mesajul va fi trimis în copie şi la aceste adrese). Scrieţi textul mesajului în
panoul din josul paginii. Pentru un format de tip HTML, selectaţi Format din bara de instrumente.
Se pot ataşa documente dând click pe Attach sau selectând Insert->Attachment. Se selectează
fişierul dorit şi se dă click pe Open (deschidere). Când aţi terminat daţi click pe butonul Send
pentru a trimite mesajul.
Dacă nu doriţi să trimiteţi mesajul imediat se salvează ca draft cu selecţia File.

9.1.3 Foldere
Mesajele de e-mail sunt sortate în mod convenabil într-o varietate de foldere. Pentru formatul
POP folderele sunt păstrate local, sortate în Local Folders.



Inbox este locul unde se plasează noile mesaje aduse de pe server.
Sent este folosit pentru a păstra copii ale mesajelor trimise.
Outbox este un depozit temporar pentru un e-mail pe cale de a fi trimis. Este util dacă se
lucrează offline (neconectat la server) sau dacă serverul de mail este temporar inaccesibil.
Drafts se foloseşte pentru a salva mesajele de mail ne-expediate.
Trash este un depozit temporar pentru mesajele care s-au şters.
Junk sortează mesajele nedorite.
Pentru a crea un folder nou selectaţi File->New->Mail Folder. Introduceţi un nume pentru noul
folder şi folosiţi mouse-ul pentru a determina locul unde va fi plasat. Se iese din dialog cu OK.
Pentru a muta un mesaj într-un folder se selectează mesajul şi se dă click dreapta pe acesta,
deschizându-se meniul de context. Se dă click pe OK pentru a muta mesajul. Copierea se face
în mod asemănator.

9.1.4 Adăugarea de adrese de e-mail
În afară de nume şi de adresa de e-mail, Evolution poate memora informaţii suplimentare despre
o persoană. Adresa de e-mail a expeditorului se poate adăuga în agenda de adrese cu click
dreapta pe adresa respectivă când este apelat un meniu de context. Pentru a introduce o
persoană nouă în agenda de adrese se dă click pe Contacts->New Contact. Se deschide un
dialog şi se introduce informaţia necesară: nume, adresa de mail, telefon, etc. La terminare se
dă click pe OK pentru adăugarea persoanei respective în agenda de adrese.

Figura E.7

9.2 Contacte
Afişează toate adresele din agenda dumneavoastră de adrese. Pentru a localiza o adresă
particulară se utilizează bara de căutare (search bar) sau se dă click pe butonul din dreapta care
afişează prima literă din numele de familie (last name) al destinatarului. Adăugaţi noi persoane
sau liste cu ajutorul barei de instrumente (toolbar).

9.3 Calendar
Ecranul iniţial arată ziua şi luna curentă şi o listă de activităţi într-un panou suplimentar în partea
dreaptă. Sunt de asemenea disponibile ecrane cu activităţi săptămânale sau lunare care se
afişează din bara de instrumente sau din meniul View (Vedere). Utilizaţi bara de căutare pentru



a găsi o întâlnire planificată. Adăugaţi întâlniri şi acţiuni cu ajutorul butoanelor de pe bara de
instrumente.

9.3.1 Calendare
Evolution poate lucra cu multiple calendare. Cu FileImport se pot importa calendare în formatul
iCalendar. Folosiţi calendarul pentru a introduce date şi întâlniri programate. Poate fi astfel
configurat încât să vă reamintească planificările făcute.

9.3.2 Adăugare întâlniri
Pentru a adăuga o nouă întâlnire în calendar se dă click pe File->New->Appointment.
În caseta Appointment (întâlnire) introduceţi detaliile, selectaţi o categorie pentru a uşura
căutările şi sortările ulterioare. Opţional se poate activa Alarm pentru aducere aminte. Dacă
evenimentul se produce frecvent se setează Recurrence. Se dă click pe butonul OK la
terminare.

9.3.3 Programare întâlnire
Pentru a programa o întâlnire cu alte persoane se selectează File->New->Meeting.
Introduceţi informaţia referitoare la întâlnire adăugând participanţii în Invitations sau Scheduling.
Participanţii se pot introduce din agenda de adrese folosind Contacts pentru a deschide o
fereastră de dialog prin care vor fi aleşi. Scheduling se poate folosi pentru a găsi o oră
convenabilă pentru toţi participanţii. Daţi click pe Autopick după configurarea participanţilor
pentru a afla timpul potrivit.

Figura E.8



10. Lucrul în shell
Cele mai multe programe în Linux pot fi executate în mod convenabil din interfaţa grafică.
În general, acţiunile legate de administrarea sistemului se rezolvă mai eficient de la linia de
comandă a unui terminal sau shell.
De câte ori vă conectaţi la un sistem Linux acesta vă plasează într-un program denumit shell.
Se poate vedea prompt-ul său aflat în josul ecranului.

Figura E.9

Shell este un program care interpretează comenzile introduse de utilizator astfel încât sistemul
de operare să le poată înţelege şi pe care apoi le trimite acestuia pentru a le executa. Rezultatul
operaţiei va fi afişat pe ecran.

Termeni uzuali în lucrul cu shell-ul:

linia de comandă (command line) este locul unde se introduc opţiunile unei comenzi sub forma:

comanda -opţiuni <nume fişier>
Exemplu:
ls –l scriptfişier.sh

shell prompt-ul marchează locul pe ecran unde trebuie plasată linia de comandă.

Exemplu de shell prompt:
[username@localhost.localdomain username]$

fereastra terminal (terminal window) este o fereastră pe ecran care conţine un shell prompt,
linia de comandă şi răspunsul de la shell.

10.1 Deschiderea unei ferestre terminal şi lucrul din Shell Prompt
O fereastră terminal se deschide din meniul principal Applications sau se dă click dreapta pe
desktop şi se selectează Open Terminal.
Introducerea sau execuţia unei comenzi se referă la tastarea unei comenzi şi apăsarea tastei
Enter. Pentru a închide o fereastră terminal fie se dă click pe icoana reprezentând un X din colţul
dreapta sus al ecranului, fie se introduce comanda exit de la shell prompt.
Un shell prompt într-o fereastră terminal poate avea următorul aspect:
[username@localhost.localdomain username]$
Există un număr mare de simboluri care se pot folosi pentru a indica sfârşitul unui shell prompt
şi, de asemenea, există mai multe opţiuni de personalizare a acestuia. Două asemenea
simboluri cel mai adesea utilizate sunt "$" şi "#".
Primul simbol,  "$", este ultimul caracter din prompt atunci când sunteţi conectaţi la sistem ca un
utilizator obişnuit. Un prompt pentru un utilizator obişnuit este de forma:



[username@localhost.localdomain username]$
Al doilea simbol, "#", este ultimul caracter din prompt atunci când sunteţi conectat ca root (cu
drepturi de administrator). Acest # apare atunci când v-aţi logat direct ca root sau după
execuţia comenzii  su pentru a deveni root. Un shell prompt pentru root este de forma:
[root@localhost.localdomain root]#
Această diferenţă vă este de ajutor pentru a vă reaminti drepturile pe care le aveţi în acel
moment.
În general, o comandă executată de la shell prompt va avea următorul format:
comandă -opţiuni <numefişier>
Atât -opţiuni cât şi <numefişier> sunt opţionale.

10.2 Bash shell
Bourne Again Shell sau bash este interpretorul implicit de comenzi din Linux.
Dacă se dă click pe icoana reprezentând un monitor şi o scoică de pe bara de instrumente din
KDE, se deschide o fereastră de consolă în care se pot introduce comenzi.
Pentru a utiliza shell-ul în mod eficient, este necesar să se cunoască structura de fişiere şi
directoare a sistemului Linux.

10.3 Sistemul de fişiere

10.3.1 Termeni uzuali cu privire la sistemul de fişiere
Iată câţiva termeni uzuali cu privire la sistemul de fişiere.
extensie

O extensie este partea din numele fişierului situată după punctul final  "." care indică tipul
fişierului. În numele de fişier manual.txt ".txt" este extensia fişierului.

  cale (path)
Calea este un şir de directoare şi sub-directoare care trebuie parcurs pentru a ajunge la
o locaţie dată în sistemul de fişiere.

acces de root (sau privilegii de root)
Pentru a avea acces de root (administrator) trebuie să fiţi conectat folosind un cont de
root. Aceasta se poate face în ecranul de login, din shell prompt sau din orice aplicaţie
care vă cere parola de root. Accesul ca root înseamnă că utilizatorul are drepturi să facă
orice doreşte în sistem; utilizaţi accesul de root cu grijă.

directorul root
Directorul root este directorul din care derivă toate celelalte directoare şi sub-directoare.

Notă
Linux utilizează termenul root în moduri diferite care pot crea confuzii noilor utilizatori. Astfel
există contul root (super-utilizatorul care are permisiunea să facă orice), directorul  propriu al
acestui utilizator (/root) şi directorul root al întregului sistem de fişiere (/).

10.3.2 Fişiere şi directoare
Structura sistemului de fişiere din Linux are aspectul unei structuri tip arbore. Se începe cu
directorul root (rădăcină), definit prin caracterul /, şi având ca ramnificaţii în jos structura de sub-
directoare.
Fiecare nod este fie un fişier, fie un director ce poate conţine alte directoare sau fişiere.
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Specificarea unui fişier se face printr-o cale ce poate fi absolută sau relativă la o locaţie.
Calea absolută începe de la rădăcină, /, şi urmăreşte ramurile sistemului de fişiere, fiecare
director fiind separat printr-un /, până când se ajunge la fişierul dorit, ex /usr/share/doc/howto.
Calea relativă foloseşte ca punct de plecare directorul în care vă aflaţi. S-au definit două intrări
de director speciale:
. directorul curent
.. părintele directorului curent

/ directorul root, punctul de plecare al arborelui de directoare
/home  directoarele (personale) ale utilizatorilor
/dev conţine fişiere speciale utilizate pentru a accesa dispozitive hardware
/etc fişiere importante pentru configurarea sistemului
/etc/init.d script-uri de boot
/usr/bin  programe general accesibile
/bin programe necesare la începutul procesului de boot
/usr/sbin programe rezervate pentru administratorul de sistem
/sbin programe rezervate pentru administratorul de sistem necesare pentru boot
/usr/include  fişiere header pentru compilatorul C
/usr/include/g++  fişiere header pentru compilatorul C++
/usr/share/doc diferite fişiere de documentaţie
/usr/share/man  pagini de manual (man pages)
/usr/src codul sursă al software-ului de sistem
/usr/src/linux codul sursă pentru kernel
/tmp, /var/tmp fişiere temporare
/usr toate programele de aplicaţii
/var fişiere de configuraţie (ca cele cu link la  /usr)
/var/log fişiere de system log
/var/adm date de administrare sistem
/lib biblioteci publice (pentru programe cu link dinamic)
/proc sistemul de fişiere pentru procese
/mnt utilizat pentru a monta sisteme de fişiere temporare
/sys sistemul de fişiere de sistem cu informaţii despre toate dispozitivele necesare
pentru kernel



/usr/local local, extensii independente de distribuţie
/opt software opţional, pachete de programe (de ex. KDE, GNOME, Netscape)

10.3.3 Directorul curent
Comanda  care indică în orice moment unde vă aflaţi în ierarhia sistemului de fişiere este pwd –
tipăreşte directorul de lucru.

Sintaxa:
pwd

Exemplu:
$ pwd
/home/xyz/Mail
$
Răspunsul indică home/xyz/Mail ca fiind directorul curent.

10.3.4 Funcţii Bash
În bash shell există posibilitatea de a introduce mai rapid datele de la tastatură prin completarea
cu tasta tab, folosind istoria comenzilor sau combinaţii de taste utile.

Completarea textului cu Tab
Completarea cu tasta tab este una din cele mai utile scurtături disponibile de la linia de
comandă. Linux are capacitatea de a "ghici"  ce  comandă, director sau nume de fişier vreţi să
introduceţi de la shell prompt. Apăsaţi tasta tab şi shell-ul oferă completări posibile pentru
cuvinte parţiale. Cu cât se tastează mai multe litere înainte de a apăsa tasta tab, cu atât se
apropie shell-ul mai mult de comanda intenţionată.

Istoria comenzilor
Nu este necesar sa tastaţi aceeaşi comandă de mai multe ori. Bash shell îşi aminteşte
comenzile trecute. Aceste comenzi sunt memorate în fişierul .bashfihistory din directorul home al
fiecărui utilizator.
Pentru a utiliza istoricul comenzilor se apasă tasta săgeată ↑ cu ajutorul căreia se parcurg în
sens invers comenzile deja folosite. Combinaţia de taste Ctrl şi R realizează o căutare în
comenzile anterioare. Apăsaţi simultan tastele Ctrl şi R şi introduceţi începutul unei comenzi
anterioare. Istoricul comenzilor se opreşte la cea mai recentă versiune a acelei comenzi. Nu se
salvează în istoric acele comenzi introduse parţial şi neurmate de Enter. Ştergerea istoriei
comenzilor se face cu history -c.

Ctrl+Z şi rularea proceselor în background
Aplicaţiile şi procesele pot fi pornite din linia de comandă. Cand se porneşte o aplicaţie de la
linia de comandă, acel shell este ocupat de ieşirea standard până la închiderea aplicaţiei.
Ecranul se umple cu caractere neinteligibile sau cu mesaje care pot fi ignorate. Pentru ca
ecranul curent să poată fi folosit în timp ce rulează o aplicaţie în acelaşi shell, se adaugă semnul
ampersand "&" la sfârşitul liniei de comandă. De exemplu, oowriter & deschide
OpenOffice.org Writer şi vă permite totodată să introduceţi comenzi noi din shell. Această
operaţie se numeşte rularea unui proces în background. În cazul unei aplicaţii deja pornite se
poate suspenda apăsând simultan tastele Ctrl şi Z şi apoi se tastează bg, după care se apasă
tasta Enter. Aplicaţia va rula acum în background.



Metacaractere
Metacaracterele ţin locul unor caractere prezente în numele de fişiere şi permit utilizatorilor să
caute sau să folosească fişiere multiple cu nume similare.
Metacaracterele sunt o parte a expresiilor regulate. Cele mai des întâlnite sunt "*" şi "?".
Semnul asterisc, "*", substituie orice caracter sau şir de caractere. Astfel a*.txt poate să se
refere la ab.txt dar şi la aardvark.txt.
Semnul de întrebare înlocuieşte un singur caracter. Expresia a?.txt se poate referi la ab.txt
sau la a1.txt, dar nu la aardvark.txt.
[abc...] înlocuieşte oricare dintre caracterele din paranteze
[a-e]   înlocuieşte oricare dintre caracterele  a, b, c, d, e
[!def] înlocuieşte orice caracter diferit de cele dintre paranteze
În cazul în care aţi uitat numele unui fişier, folosind metacaractere se pot executa acţiuni asupra
unui fişier sau mai multor fişiere fără să se cunoască numele complet. Se tastează ce se
cunoaşte şi se substituie restul cu un metacaracter.

Notă
Pagina de manual man bash conţine informaţii suplimentare despre metacaractere şi expresii
regulate.

10.3.5 Combinaţii utile de taste
Când se lucrează în linia de comandă aveţi la dispoziţie câteva combinaţii de taste care vă pot
ajuta în sesiune.

Taste Acţiune

[Ctrl]+[K] La editarea unei comenzi această combinaţie şterge tot ce s-a introdus
de la poziţia curentă a cursorului înainte

[Ctrl]+[D] Această combinaţie termină aplicaţia sau procesul curent. Apasând de
două ori se iese din shell

[Ctrl]+[R] Caută în istoria comenzilor o intrare care începe cu literele introduse
[Ctrl]+[Z] Suspendă aplicaţia curentă. Introducerea lui bg după [Ctrl]+[Z] face ca

programul să ruleze în background
[Ctrl]+[C] "Omoară" un program. Aceasta trebuie să fie ultima soluţie. Încercaţi

oprirea programului cu alte metode mai întâi
[Ctrl]+[L] Şterge fereastra terminal

10.3.6 Ştergerea şi resetarea terminalului
O fereastră terminal începe să se aglomereze relativ repede. Se poate ieşi din fereastră şi apoi
să se deschidă alta nouă sau se poate şterge conţinutul cu comanda clear, lăsând doar un
nou shell prompt în fereastră.
Se poate şterge ecranul cu ajutorul tastelor Ctrl şi L.
Comanda reset aduce fereastra terminal la valorile implicite.

10.3.7 Redirecţionarea fişierelor
În mod normal ieşirea standard a shell-ului este ecranul sau fereastra consolă şi intrarea
standard este tastatura.
Cu o intrare redirecţionată datele se preiau dintr-un fişier în loc să fie introduse de la tastatură.
Ieşirea redirecţionată transmite comanda unui fişier în loc de ecran.
Redirecţionarea intrării şi a ieşirii se face cu ajutorul unui set de operatori.



Pentru a redirecţiona intrarea se foloseşte semnul ‘’<’’.
<     redirecţionează conţinutul unui fişier într-o comandă.

Sintaxa:
comanda < fişier

Exemplu:
Se trimite prin comanda mail un mesaj pentru utilizatorul adrian preluat dintr-un fişier existent
pe disc în loc să fie introdus de la tastatură.
$mail adrian < raport

Redirecţionarea ieşirii se face cu semnul ‘’>’’.
> redirecţionează ieşirea unei comenzi într-un fişier nou şi înlocuieşte conţinutul unui fişier
existent cu ieşirea.

Sintaxa:
comandă > fişier

Exemplu:
$ls –la > listare
Fişierul listare va conţine lista fişierelor din directorul curent.

Notă:
Dacă fişierul denumit listare există deja, este suprascris. Shell-ul nu va avertiza asupra acestui
lucru.

Adăugarea ieşirii la sfârşitul unui fişier existent:

Sintaxa:
comandă >> fişier
Dacă fişierul nu există, el va fi creat.

10.3.8 Redirecţionarea ieşirii unei comenzi prin operatorul pipe
Caracterul ‘’|’’ este denumit pipe. Acesta este un instrument puternic ce permite ca ieşirea unei
comenzi să devină intrarea unei alte comenzi, fără a mai fi necesară crearea unor fişiere
temporare. O comandă multiplă creată în acest mod se numeşte pipeline.

Formatul general este:
comanda1 | comanda2 | comanda3 . . .
Ieşirea  comenzii1 devine intrare pentru comanda2. Ieşirea comenzii2 se foloseşte ca intrare
pentru comanda3.

10.3.9 Compresia şi arhivarea fişierelor
Este folositor să se grupeze mai multe fişiere într-un singur fişier pentru backup, pentru
transferul într-un alt director sau pe un alt calculator. De asemenea, este util să se comprime
fişierele de dimensiuni mari; fişierele comprimata ocupă un spaţiu mai mic pe disc şi se
descarcă mai repede prin Internet.
Este important să se înteleagă deosebirea dintre un fişier arhiva şi un fişier comprimat.
Un fişier arhivă este o colecţie de fişiere şi directoare stocate într-un singur fişier. O arhivă nu
este comprimată, ea ocupând acelaşi spaţiu cât toate fişierele individuale şi directoarele
însumate. Un fişier comprimat este o colecţie de fişiere şi directoare stocate într-un fişier care
ocupă un spaţiu pe disc mai mic decât toate fişierele însumate. Dacă vă preocupă spaţiul pe
disc atunci comprimaţi fişierele rar folosite sau creaţi un singur fişier arhivă pe care-l comprimaţi.

Notă
Un fişier arhivă nu este comprimat, dar un fişier comprimat poate să conţină o arhivă.



10.4 Compresia fişierelor din Shell Prompt
Utilitarele de compresie din shell prompt sunt bzip2, gzip, şi zip. Se recomandă folosirea
utilitarului bzip2 pentru că asigură cea mai bună compresie şi se găseşte în cele mai multe
sisteme de operare de tip LINUX. Utilitarul gzip se află de asemenea în cele mai multe sisteme
de operare de tip LINUX. Transferul de fişiere dintre Linux şi alte sisteme de operare ca MS
Windows, se face cu zip pentru că este compatibil cu programele de compresie disponibile în
Windows.

Utilitar de compresie Extensia fişierului Utilitar de dezarhivare
bzip2 .bz2 bunzip2
gzip .gz gunzip
zip .zip unzip

Prin convenţie, fişierele comprimate cu bzip2 primesc extensia .bz2, fişierele comprimate cu gzip
primesc extensia .gz, iar fişierele comprimate cu zip au extensia .zip.
Fişierele comprimate cu bzip2 sunt dezarhivate cu bunzip2, fişierele comprimate cu gzip sunt
dezarhivate cu gunzip, iar fişierele comprimate cu zip sunt dezarhivate cu unzip.

Bzip2 şi Bunzip2
Pentru a comprima un fişier cu bzip2 se introduce comanda următoare din shell prompt:
bzip2 filename
Fişierul este comprimat şi salvat ca filename.bz2.
Pentru a expanda un fişier comprimat, se introduce comanda următoare:
bunzip2 filename.bz2
Fişierul comprimat filename.bz2 este şters şi înlocuit cu fişierul filename.
Se poate folosi bzip2 pentru a comprima fişiere şi directoare multiple în acelaşi timp introducând
o listă cu spaţiu între ele:
bzip2 filename.bz2 file1 file2 file3 /usr/work/school
Comanda de mai sus comprimă file1, file2, file3 şi conţinutul directorului /usr/work/school/ şi le
plasează într-un fişier cu numele filename.bz2.

Notă
Pentru informaţii suplimentare, introduceţi man bzip2 şi man bunzip2 din shell prompt pentru
a citi paginile man referitoare la  bzip2 şi bunzip2.

Gzip şi Gunzip
Pentru a comprima un fişier cu gzip introduceţi comanda următoare din shell prompt:
gzip filename
Fişierul este comprimat şi salvat ca filename.gz.

Pentru a expanda un fişier comprimat se introduce comanda următoare:
gunzip filename.gz
Fişierul comprimat filename.gz este şters şi înlocuit cu fişierul filename.

Se poate folosi gzip pentru a comprima fişiere şi directoare multiple în acelaşi timp
introducându-le într-o listă cu spaţiu între ele:
gzip -r filename.gz file1 file2 file3 /usr/work/school
Comanda de mai sus comprimă file1, file2, file3 şi conţinutul directorului /usr/work/school/ şi le
plasează într-un fişier cu numele filename.gz.



Notă
Pentru informaţii suplimentare, introduceţi man gzip şi man gunzip din shell prompt pentru a
citi paginile man referitoare la gzip şi gunzip.

Zip şi Unzip
Pentru a comprima un fişier cu comanda zip, se introduce linia următoare:
zip -r filename.zip filesdir
În acest exemplu, filename.zip reprezintă fişierul care-l creaţi iar filesdir reprezintă directorul în
care se doreşte introducerea noului fişier de tip zip. Opţiunea -r specifică includerea tuturor
fişierelor conţinute în directorul filesdir în mod recursiv.

Pentru a extrage conţinutul unui fişier de tip zip, se introduce comanda următoare:
unzip filename.zip

Se poate folosi zip pentru a comprima fişiere şi directoare multiple în acelaşi timp,
introducându-le într-o listă cu spaţiu între ele:
zip -r filename.zip file1 file2 file3 /usr/work/school
Comanda de mai sus comprimă file1, file2, file3 şi conţinutul directorului /usr/work/school/  şi le
plasează într-un fişier cu numele filename.zip.

Notă
Pentru informaţii suplimentare, introduceţi man zip şi man unzip din shell prompt pentru a citi
paginile man referitoare la zip şi unzip.

10.5 Arhivarea fişierelor din Shell Prompt
Un fişier de tip tar este o colecţie de mai multe fişiere sau/şi directoare într-un fişier. Acesta
este un mod recomandabil pentru a face salvarea de programe (backup) şi arhive.
Opţiunile comenzii tar includ:
. –c creeaza o arhivă nouă
. –f folosit cu opţiunea  -c, creeaza un fişier tar cu numele fişier specificat
           folosit cu opţiunea  -x, dezarhivează fişierul specificat
. –t arată lista fişierelor din arhiva tar
. –v arată progresul fişierelor în curs de arhivare
. –x extrage  fişierele din arhivă
. –z comprimă fişierul de tip tar cu gzip
. –j comprimă fişierul de tip tar cu bzip2

Pentru a crea un fişier de tip tar, introduceţi comanda:
tar -cvf filename.tar directory/file

În acest exemplu, filename.tar reprezintă fişierul care se creează, iar directory/file reprezintă
directorul şi fişierul care urmează a fi introduse în arhivă.
Se pot arhiva cu tar fişiere şi directoare multiple în acelaşi timp, introducându-le într-o listă cu
spaţiu între ele:
 tar -cvf filename.tar /home/mine/work /home/mine/school

Comanda de mai sus plasează toate fişierele din sub-directoarele work şi school din
/home/mine într-un fişier nou numit filename.tar din directorul curent.

Pentru a lista conţinutul unui fişier tar, se introduce:
tar -tvf filename.tar

Pentru a extrage conţinutul unui fişier tar, se introduce:
tar -xvf filename.tar



Această comandă nu şterge fişierul tar ci plasează copii ale conţinutului nearhivat în directorul
curent de lucru, păstrând structura de director folosită de fişierul arhivat. De exemplu, dacă
fişierul tarfile conţine un fişier numit bar.txt dintr-un director foo/, atunci prin extragerea fişierului
arhivat se crează un director foo/ în directorul curent de lucru cu fişierul bar.txt în acest director.
Amintiţi-vă că tar nu comprimă fişierele în mod implicit. Pentru a crea un fişier arhivat şi
comprimat, folosiţi opţiunea  -j:

tar -cjvf filename.tbz file

Fişierele tar comprimate cu bzip2 au convenţional extensia .tbz; uneori utilizatorii arhivează
fişierele folosind extensia tar.bz2.
Comanda de mai sus crează un fişier arhivă şi apoi îl comprimă cu numele filename.tbz. Dacă
se dezarhivează fişierul filename.tbz cu comanda bunzip2, atunci fişierul filename.tbz este
şters şi înlocuit cu filename.tar.
Un fişier bzip tar se poate expanda şi dezarhiva cu o singură comandă:
tar -xjvf filename.tbz

Pentru a crea un fişier arhivat cu tar şi comprimat cu gzip, se utilizează opţiunea -z:

tar -czvf filename.tgz file

Fişierele tar comprimate cu gzip au convenţional extensia .tgz.
Această comandă crează fişierul de tip arhivă filename.tar şi îl comprimă cu numele de fişier
filename.tgz. Fişierul cu numele filename.tar nu este salvat. Dacă se decomprimă fişierul
filename.tgz cu comanda gunzip, atunci fişierul filename.tgz este şters şi înlocuit cu
filename.tar.
Se poate expanda un fişier gzip tar printr-o singură comandă:
tar -xzvf filename.tgz

Notă
Introduceţi comanda man tar pentru a afla mai multe informaţii despre comanda tar.

mtools
mtools sunt un set de comenzi pentru lucrul cu sisteme de fişiere MS-DOS. Comenzile incluse
permit adresarea unui floppy ca  a:, la fel ca şi sub MS-DOS. Comenzile seamănă cu cele din
MS-DOS cu singura deosebire că au ca prefix un m:
mdir a: afişează conţinutul unui floppy disk din unitatea a:
mcopy Testfile a: copiază fişierul Testfile pe floppy disk
mdel a:Testfile şterge Testfile de pe a:
mformat a: formatează un floppy disk în format MS-DOS  (cu comanda  fdformat)
mcd a: directorul curent devine a:
mmd a:test crează subdirectorul test pe floppy disk
mrd a:test şterge subdirectorul test de pe floppy disk



11. Utilizatori şi drepturi de acces

11.1 Drepturi de acces la fişiere şi directoare
Fiecare fişier sau director are stabilite drepturi specificând utilizatorii care au acces la datele
respective şi cum le pot folosi (citire, scriere şi/sau execuţie). Pentru a afla drepturile de acces
se foloseşte comanda ls cu opţiunea –l.
Primul câmp al fiecărei linii din listă precizează tipul fişierului (- indică un fişier obişnuit, d-
director), urmează apoi drepturile de acces în seturi de câte trei caractere pentru proprietar-
grup-ceilalţi utilizatori.
Convenţiile sunt:
r drept de citire (read)
w drept de scriere (write)
x drept de execuţie (execute)
- fără  drepturi
În cazul unui director:
r directorul poate fi citit
w directorul poate fi modificat (se pot adăuga sau şterge fişiere)
x directorul poate fi accesat (cu comanda cd)

Model de drepturi de acces pentru un fişier
-rw-r----- 1 tux project3 14197 Jun 21 15:03 Roadmap
Model de drepturi de acces pentru un director
drwxrwxr-x 1 tux project3 35 Jun 21 15:15 ProjectData

11.2 Schimbarea drepturilor de acces la fişiere
Modificarea drepturilor de acces la un fişier sau director se poate face de către proprietar sau de
către administrator (root) prin comanda chmod. Sintaxa foloseşte trei caractere, reprezentând
drepturile proprietarului u, ale grupului g şi ale celorlalţi utilizatori o, urmate de un argument care
poate fi un fişier, un director sau o listă.
Drepturile se pot reprezenta fie printr-un echivalent numeric:
read=4, write=2, execute=1
fie printr-o literă:
citire=r, scriere=w, execuţie=x.
Permisiunea 4 sau r dă dreptul la citire. Dacă se doreşte şi dreptul la scriere se adună 4+2 care
dau permisiunea 6.
Notaţia simbolică foloseşte o literă pentru categoria de utilizatori, un operator şi permisiunile
respective. Operatorii pot fi:
+ adaugă drepturi
-  şterge drepturi
= stabileşte drepturi

Exemplu:

Drepturile de scriere şi citire pentru proprietar se pot defini simbolic u=rw

Sintaxa:
chmod nnn [lista argumente]                                         modul numeric
chmod [cine]operator[perm] [lista argumente]                modul simbolic
unde nnn sunt cele trei cifre care reprezintă drepturile pentru proprietar, grup şi alţi utilizatori;
cine poate fi u (proprietarul), g (grupul), o (ceilalţi utilizatori) sau a (toţi utilizatorii), iar perm
oricare din r, w, x.
Opţiuni:



-R recursiv (schimbă drepturile în toată structura directorului, recursiv)

Exemplu:
Dacă se doresc pentru fişierul rapoarte următoarele drepturi:
proprietar: citire, scriere, execuţie.
grup: citire, execuţie
ceilalţi: citire
comanda folosită va fi:
chmod 754 rapoarte sau chmod u=rwx,g=rx,o=r rapoarte

Opţiuni:
-R  modifică recursiv în director şi subdirectoare
Dacă se dă celorlalţi utilizatori permisiunea de acces la un fişier (g sau o) este necesar ca
aceştia să aibă cel puţin dreptul de execuţie (x) în directorul din care face parte acel fişier.
Un mod simplu de a acorda această permisiune în directorul respectiv:
chmod 711 .  sau chmod u=rw,+x .  sau  chmod u=rwx,go=x .
unde punctul (.) indică acest director.

11.3 Schimbarea proprietarului
Proprietarul unui fişier poate fi schimbat prin comanda chown.
Doar un utilizator privilegiat (root) sau proprietarul fişierului au posibilitatea de a folosi această
comandă.

Sintaxa:
#chown [opţiuni] proprietar_nou fişier
unde opţiuni este:
-R  recursiv

Exemplu:
# chown root fişier_backup

11.4 Schimbarea grupului
Oricine poate schimba grupul fişierelor proprii cu un alt grup de care aparţin folosind comanda
chgrp.

Sintaxa:
chgrp [opţiuni] grup fişier
unde opţiuni este:
-R  recursiv

Exemplu:
$chgrp asy brokerarh



12. Comenzi importante în Linux

12.1 Comenzi relative la fişiere
Fişierul este cea mai mică unitate de informaţie care este memorată sub un nume şi este
recunoscută de un sistem. Pentru a crea, copia, redenumi şi schimba drepturile de acces ale
fişierelor se pot folosi următoarele comenzi.

12.1.1 Listare fişiere
Informaţii despre fişierele şi subdirectoarele unui director pot fi afişate cu ajutorul comenzii ls. În
forma cea mai simplă ls dă lista numelor de fişier din directorul curent.

Sintaxa:
ls [opţiuni] [fişier(e)]
Opţiuni:
-l lista detaliată
-a afişează fişierele ascunse

Exemplu:
$ ls -l
$ ls -a

12.1.2 Copiere fişiere
Comanda cp (copy - copiere) copiază conţinutul unui fişier (sursă) într-un alt fişier (destinaţie).

Sintaxa:
cp [opţiuni] sursă destinaţie

Opţiuni:
-i  interactiv (cere confirmarea utilizatorului înainte de a executa comanda)
-r  recursiv (copiază recursiv directoare, împreună cu toate sub-directoarele lor)

Exemplu:
$cp usr.cnf  usr.sav
Acum există două copii identice ale fişierului, complet independente, fiecare având propriile
blocuri de date şi intrări separate în tabela de directoare.

12.1.3 Mutare fişiere
Redenumirea unui fişier prin comanda mv (move - mutare).

Sintaxa:
mv [opţiuni] sursă destinaţie

Opţiuni:
-b creează o copie de backup a sursei înainte de mutare
-i  interactiv (cere confirmarea utilizatorului înainte de a executa comanda)
-f  nu aşteaptă confirmarea, forţând mutarea fişierului chiar şi în cazul suprascrierii unui fişier
destinaţie existent.

Exemplu:
$mv fişier_vechi  fişiere_arhivate
În urma execuţiei comenzii există acum fişiere_arhivate iar fişier_vechi nu mai există. Nu s-a
schimbat decât  intrarea în tabela de directoare, conţinutul fişierului a rămas neschimbat.

12.1.4 Ştergere fişiere
Comanda de ştergere a fişierelor este rm  (remove - ştergere).

Sintaxa:



rm [opţiuni] fişier / director

Opţiuni:
-i  interactiv (cere confirmarea utilizatorului înainte de a executa comanda)
-r recursiv (şterge recursiv fişierele din directorul specificat, iar apoi şterge şi directorul
împreună cu toate sub-directoarele existente)
-f  nu aşteaptă confirmarea, forţând ştergerea fişierului.

Exemplu:
$rm fişier_temporar
Dacă listăm acum conţinutul directorului, fişier_temporar nu mai apare. S-a şters intrarea din
tabela de directoare şi deşi conţinutul fişierului a rămas pe disc, sistemul nu mai poate identifica
acele blocuri de date cu un nume de fişier. Nu există nici o comandă de anulare a ştergerii.
Se recomandă folosirea comenzii rm –i, prin care utilizatorului i se cere confirmarea.

12.1.5 Link spre alt fişier
Comanda ln creează o legătură (link) sau o cale adiţională de acces la un fişier dat.

Sintaxa:
ln  [opţiuni] sursă  destinaţie
-s creează o legătură simbolică
Comanda ln face o legătura între sursă şi destinaţie prin crearea unei intrări de director care se
referă la destinaţie.
O legătură simbolică crează o cale nouă către un alt fişier sau director.

12.1.6 Schimbarea directorului curent
Comanda cd execută schimbarea directorului. cd acceptă atât numele relative cât şi absolute
pentru a desemna calea.

Sintaxa:
cd [nume-director]

Exemple:
cd revenire în directorul de referinţă (home)
cd / schimbă în directorul root (/)
cd .. directorul aflat cu un nivel mai sus
cd../.. directorul aflat cu două niveluri mai sus
cd /home/xyz/Mail calea absolută a directorului  (notaţi un / în faţă)
cd calea relativă  (fără  /)

12.1.7 Crearea unui director
Pentru a crea un nou director se utilizează comanda mkdir (make directory - creare director):

Sintaxa:
mkdir [opţiuni] nume-director
Argumentul nume-director  poate fi un nume, în care caz noul director este creat în directorul de
lucru curent, sau o cale. Dacă se doreşte crearea unui nou director denumit proiecte în directorul
/home/lucrari se dă următoarea comandă:
$ mkdir /home/lucrari/proiecte
Acelaşi rezultat se obţine prin:
$ cd /home/lucrari
$ mkdir proiecte
Pentru a crea un director într-un alt director sunt necesare drepturi de scriere.
Mai multe directoare pe un acelaşi nivel se pot crea printr-o singură comandă:
$ mkdir director1 director2 director3



Dacă este necesar să se creeze o cale pentru director se foloseşte opţiunea mkdir -p.
Comanda următoare crează un director numit ghid_utilizare şi toate celelalte directoare
specificate care nu există încă.
$ mkdir -p proiecte/proiectulmeu/ghid_utilizare

12.1.8 Ştergerea unui director
Un director trebuie să fie gol înainte de a putea fi şters. Dacă există fişiere, acestea trebuie să
fie şterse înainte. Directorul curent nu poate fi şters, trebuie să ieşiţi din el.

Sintaxa:
rmdir director

Exemplu:
$rmdir /home/lucrari/temp

12.1.9 Găsirea unor fişiere
Comanda find va căuta recursiv în directorul indicat, fişierele care corespund criteriilor
specificate. find poate apoi să listeze fişierele.

Sintaxa:
find cale [opţiuni de căutare]

Opţiuni:
-name şirdecăutare - caută fişiere sau directoare care conţin în nume şirul dat, inclusiv
metacaractere.

Exemplu:
$ find /home  -name Start

12.1.10 Concatenarea fişierelor
Comanda cat afişează conţinutul unuia sau mai multor fişiere text la terminalul standard de
ieşire (ecran).
Comanda cat utilizată singură afişează în ecou pe ecran orice text introdus de la tastatură până
se încheie cu tastele Ctrl şi D.

Sintaxa:
cat [opţiuni] [fişier]

Opţiuni
-n numerotează toate liniile de ieşire

Exemplu
$ cat readme.txt afişează conţinutul fişierului text pe ecran
$cat fişier1 fişier2 > fişier3 concatenează (alătură) fişier1 şi fişier2 şi scrie
rezultatul în fişier3.



12.1.11 Vizualizarea fişierelor cu less
Comanda less citeşte fişierele şi le scrie la terminal, oprindu-se după fiecare ecran.
Deplasarea cu o jumătate de pagină în sus sau în jos se face cu PageUp respectiv PageDown
iar cu un ecran în jos cu Space. Saltul la începutul sau sfârşitul fişierului se face cu Home sau
End. Apăsaţi Q pentru ieşirea din program.

Sintaxa:
less fişier

12.1.12 Caută un text într-un fişier
Utilitarul grep (global regular expression print) se utilizează pentru a căuta un şir de caractere
(text) ce satisface o condiţie dată. Specificarea şabloanelor ce descriu şiruri de caractere se face
utilizând o notaţie specială numită expresie regulată.
Expresiile regulate din utilitarul grep sunt descrise între apostroafe.
Caracterele ``$'', ``*'', ``['', ``^'', ``|'',``('', ``)'', şi ``\''  dintr-o expresie se vor include de asemenea
între apostroafe pentru că au o semnificaţie şi în shell.

Sintaxa:
grep [opţiuni] expresie_regulată [fişier(e)]

Opţiuni:
-i nu face distincţie între literele mari şi mici
-H listează numele de fişiere, nu şi liniile unde s-a găsit textul
-n precede fiecare linie cu numărul liniei din fişier
-l listează doar fişierele care nu conţin textul

Exemple:
$grep 'marian' /etc/passwd comanda va lista pe ecran liniile în care apar ca utilizatori
atât marian cât şi mariana.

12.1.13 Comparator de fişiere
Comanda diff compară două fişiere, directoare, etc, şi raportează toate diferenţele dintre ele.
Acceptă doar fişiere ASCII. Formatul de ieşire listează toate liniile care sunt diferite.

Sintaxa:
diff [opţiuni] fişier1 fişier2

Opţiuni:
-i ignoră majusculele
-w ignoră spaţiile albe (caracterele <spaţiu> şi <tab>)
-q  raportează doar dacă cele două fişiere diferă între ele
-u  produce o ieşire care poate fi citită mai uşor

12.1.14 Fişiere pe dischete şi CD-ROM
Comanda mount se foloseşte pentru a monta orice dispozitiv de stocare ca hard disk, CD-ROM,
dischetă, într-un director din sistemul de fişiere Linux

Sintaxa:
mount [opţiuni] [dispozitiv] punctdemontare

Opţiuni:
-r montează doar read-only (citire)
-t filesystem Specifică sistemul de fişiere, de obicei ext2 pentru hard disk-uri, msdos pentru
MS-DOS, vfat pentru sistemul de fişiere Windows şi iso9660 pentru CD



Pentru hard disk-urile nedefinite în fişierul /etc/fstab, trebuie specificat tipul dispozitivului. În
acest caz doar root îl poate monta. Dacă sistemul de operare trebuie să fie montat şi de alţi
utilizatori se introduce opţiunea user în linia corespunzătoare din fişierul /etc/fstab (separat cu
virgulă) şi se salvează modificarea.

Exemplu
# mount /media/cdrom/
# mount /media/floppy/
Comanda umount demontează un dispozitiv montat în sistemul de fişiere. Pentru a preveni
pierderea de date rulaţi această comandă înainte de a scoate un suport de informaţii din drive.
Doar utilizatorul root poate executa comenzile mount şi umount. Pentru ceilalţi utilizatori se va
edita fişierul /etc/fstab.

Sintaxa:
umount [opţiuni] punctdemontare

Exemplu
# umount /media/cdrom/
# umount /media/floppy/

12.2 Comenzi de sistem

12.2.1 Spaţiul liber pe disc
Comanda df (disk free) raportează spaţiul total pe disc, spaţiul utilizat şi spaţiul liber de pe
toate dispozitivele montate. Dacă se specifică un director atunci informaţia este limitată la drive-
ul unde este situat directorul respectiv.

Sintaxa:
df [opţiuni] [director]

Opţiuni:
-h Indică numărul de blocuri alocate în gigabytes, megabytes sau kilobytes
-T Tipul sistemului de fişiere (ext2, nfs, etc.)

Exemplu:
#df –h /   spaţiul liber pe disc din / (rădăcina)

12.2.2 Utilizarea discului
Comanda du indică spaţiul utilizat de unul sau mai multe directoare în mod recursiv.

Sintaxa:
du [opţiuni] [cale]

Opţiuni:
-a  afişează dimensiunea fiecărui fişier individual
-s  afişează doar dimensiunea totală calculată
-h  ieşirea într-o formă uşor de citit
-k  raportează dimensiunea blocurilor în kilobytes
Dacă nu se indică nici un nume, se foloseşte directorul curent.

Exemplu:
$du –k

12.2.3 Memoria RAM
Comanda free afişează informaţii despre memoria RAM şi spaţiul swap.
free [opţiuni]
-b ieşirea în bytes



-k ieşirea în kilobytes
-m ieşirea în megabytes

12.2.4 Tipărirea sau modificarea datei şi orei
date  afişează data şi ora curentă. Administratorul are dreptul să modifice data şi ora prin
setarea ceasului de timp real al sistemului.

Sintaxa:
# date mmddHHMM[[cc]yy]]

Opţiuni:
mm  numărul lunii
dd  ziua din luna
HH  ora (sistem 24 ore)
MM  minutul
cc   secolul minus 1
yy   ultimele două cifre ale anului
Luna, ziua, anul şi secolul pot fi omise.
De exemplu:
#date 10080945
Introduce data 8 octombrie ora 9:45
Comanda fără opţiuni va afişa data şi ora sistemului.

13. Procese
top afişează procesele Linux.
top [opţiuni]

13.1 Starea proceselor
Comanda ps este folosită pentru informaţii despre procesele active care rulează în sistemul
Linux.

Sintaxa:
ps [opţiuni]

Opţiuni:
-a       toate procesele
-e       fiecare proces care rulează în prezent
-f       toate informaţiile despre procesele afişate
-aux  afişează o listă detaliată a tuturor proceselor independent de proprietar

Exemplu:
$ps –ef  informaţii despre fiecare proces

13.2 Terminarea unui proces
kill  trimite un semnal unui proces specificat pentru a-l încheia.

Sintaxa:
kill [-semnal] pid
kill [-s semnal] pid

Opţiuni:
-s  trimite semnal proceselor selectate
-l  tipăreşte lista numelor simbolice care pot fi folosite ca semnal
-9  trimite un semnal KILL în loc de semnalul TERM, încheind procesul specific în aproape
toate cazurile



pid este un număr întreg care identifică ce procese ar trebui să primească semnalul. PID este
afişat de către comanda ps.
killall [opţiuni] numeproces
Această comandă este similară cu kill, but utilizează numele procesului (în loc de process ID) ca
argument, terminând toate procesele cu acel nume.

14. Reţeaua

14.1 Trimiterea de pachete în ecou în reţea
ping trimite pachete în ecou către un calculator host şi raportează dacă acesta a răspuns sau
nu. Dacă s-a primit un răspuns, ping tipăreşte host is alive, altfel după un interval se va afişa
mesajul no answer.

Sintaxa:
ping [opţiuni] host|adresă IP

Opţiuni:
-c număr    determină numărul total de pachete trimise (implicit nu este o limită)
-f flood ping: trimite cât de multe pachete de date este posibil, rezervat pentru root, pentru
testarea reţelei

Exemple:
$ping 172.20.12.1
172.20.12.1 is alive          ping a primit răspuns
$ping SA1001
UX:ping: INFO: no answer from SA1001_1       ping nu a primit răspuns

14.2 Conectarea la distanţă
Să presupunem că lucraţi pe un calculator şi doriţi ca executaţi anumite comenzi pe o maşină la
distanţă. Programul telnet vă permite să va conectaţi la serverul Linux respectiv.
Pentru o simplă transmisie de fişiere de pe o maşină pe alta nu este necesară o sesiune
terminal; se recomandă folosirea programului de transfer de fişiere ftp.

Telnet
Comanda telnet permite comunicarea cu un alt calculator din reţea folosind protocolul
TELNET.

Sintaxa:
telnet [opţiuni] [ host [ port ] ]

Opţiuni:
-8 foloseşte opt biţi de date pentru intrare şi ieşire
-L opt biţi de date pentru ieşire
-a login automat în sistemul de la distanţă
-d modul depanare
host numele oficial al maşinii, un alias sau adresa de internet a calculatorului la distanţă
port indică un număr de port (adresa unei aplicaţii). Dacă nu este specificat se foloseşte
         portul telnet implicit.
După stabilirea legăturii se deschide sesiunea în directorul home al utilizatorului şi telnet intră în
modul input.

Comenzi telnet:
close închide o sesiune TELNET şi se întoarce în modul comandă
logout similar cu close
open host deschide o conexiune către host



quit închide sesiunea şi iese din telnet
? [comandă] informaţii despre telnet (ajutor). Dacă se specifică o comandă, se va tipări
informaţia referitoare la acea comandă; altfel se va lista rezumatul comenzilor din telnet

Exemplu:
$telnet 172.20.45.1
Se aşteaptă numele utilizatorului şi parola:
Trying...
   Connected to 172.20.45.1.
   Escape character is '^]'.

   login:
   Password:

După realizarea conectării, se poate lucra în linie de comandă pe maşina la distanţă în acelaşi
mod ca atunci când lucrăm la un terminal conectat direct la acea maşină. La încheierea lucrului
se iese din sesiune. Dacă dintr-un anumit motiv nu se poate ieşi normal din telnet se vor apăsa
simultan tastele Ctrl şi ]. La afişarea prompt-ului se va tasta quit.
telnet>quit

14.3 Alte comenzi

14.3.1 Parole
Utilizatorii îşi pot schimba oricând parolele proprii cu comanda passwd. Administratorul poate
folosi comanda pentru a schimba parola oricărui utilizator din sistem.
passwd [opţiuni] [numeutilizator]

Comanda su permite logarea cu un nume de utilizator diferit dintr-o sesiune în curs. Se
specifică un nume de utilizator şi parola respectivă. Parola nu este cerută pentru root care poate
să-şi asume identitatea oricărui utilizator. Comanda fără argumentul nume necesită parola de
root la schimbarea în administrator.
su [opţiuni] [numeutilizator]

15. Pagini de manual (Man Pages)
Paginile de manual sunt o parte esenţială a oricărui sistem Linux. Ele explică modul de utilizare
a unei comenzi împreună cu toate opţiunile şi parametrii acestora.
O pagină de manual este afişată din shell prin introducerea comenzii man urmată de numele
comenzii.
Pentru pagina man care descrie comanda ls se va scrie:
$ man ls

16. Oprirea sistemului
Pentru a evita pierderea datelor este necesar să se folosească acest program înainte de a a opri
sistemul.
halt [opţiuni]
Unele calculatoare se sting singure după shutdown. În caz contrar se poate stinge calculatorul
după apariţia mesajului System halted.
Calculatorul poate fi repornit folosind comanda:
reboot [opţiuni]
Partea vizibilă a consolei se şterge cu ajutorul comenzii clear.
Aceasta nu are opţiuni.

17. Editorul de text  vi



vi este un editor de text din shell prompt. La fel ca şi în cazul comenzii less, deschiderea unei
instanţe vi nu deschide o fereastră grafică. Conţinutul fişierului care este editat apare în
fereastra terminal curentă. vi se poate utiliza pentru editarea textelor şi în cazul când interfaţa
grafică nu funcţionează. Editorul lucrează cu comenzi de la tastatură.
vi are trei moduri de lucru. În modul comandă tastele sunt interpretate ca elemente de comandă.
Modul insert interpretează toate tastele ca introducând un text. Modul ultima linie se foloseşte
pentru comenzi mai complexe care se introduc din ultima linie a ecranului.
O listă a principalelor comenzi din vi este prezentată în tabelul de mai jos.

Tasta Acţiune
ESC Trece în modul ultima linie.
i Trece în modul inserare (caracterele apar în poziţia curentă a cursorului).
a Trece în modul inserare (caracterele apar după poziţia curentă a cursorului).
A Trece în modul inserare (caracterele se adaugă la sfârşitul liniei).
R Trece în modul comandă (suprascrie vechiul text).
r Trece în modul inserare şi suprascrie fiecare caracter.
s Trece în modul inserare (caracterul unde este poziţionat cursorul este înlocuit de

caracterul nou introdus).
C Trece în modul inserare (restul liniei este înlocuit de textul nou).
o Trece în modul inserare (se introduce o linie nouă după linia curentă).
O Trece în modul inserare (se introduce o linie nouă înainte de linia curentă).
x Şterge caracterul curent.
dd Şterge linia curentă.
dw Şterge până la sfârşitul cuvântului curent.
cw Trece în modul inserare (restul cuvântului curent este suprascris de textul nou

introdus).
u Anulează ultima comandă.
J Uneşte linia curentă cu linia următoare.
. Repetă ultima comandă.
: Trece în modul ultima linie.
Fiecare comandă poate fi precedată de un numar care specifică de câte ori se va executa
comanda care urmează. Se şterg trei cuvinte odată cu 3dw. Comanda 10x şterge zece
caractere după cursor iar 20dd şterge douăzeci de linii.



Comenzile cele mai importante care se pot da din ultima linie sunt prezentate în tabela
următoare :
:q! Ieşire din vi fără salvare
:w numefişier Salvarea modificările fişierului cu numele numefişier
:x Salvează fişierul modificat şi iese din editor
:e numefişier Editează (încarcă) fişierul numefişier
:u Anulează ultima comandă edit

18. Internet

18.1 Browser-ul de Internet Konqueror
Konqueror nu este doar un manager de fişiere plin de resurse, el este şi un browser de web
modern. Dacă porniţi browser-ul cu icoana de pe panou, Konqueror se deschide cu profilul de
web browser. Ca browser, Konqueror oferă tabbed browsing, posibilitatea de a salva paginile
web cu grafică, cuvinte cheie Internet, bookmark şi suport pentru Java şi JavaScript.
Porniţi Konqueror din meniul principal sau prin comanda konqueror. Pentru a încărca o pagină
de web, introduceţi adresa în bara de locaţie, de exemplu http: //www.suse.com. Konqueror
încearcă să ajungă la adresă şi afişează pagina. Introducerea protocolului la începutul adresei
(http:// în acest caz) nu este strict necesară. Programul poate să completeze adresa automat,
dar acest lucru este valabil doar pentru adrese de web. Pentru adrese de FTP, introduceţi
întotdeauna ftp:// la începutul câmpului de intrare.

Figura E.11.

18.1.1 Tabbed Browsing
Dacă folosiţi deseori mai multe pagini în acelaşi timp atunci metoda tabbed browsing face mai
uşoară trecerea de la o pagină la alta. Site-urile web se încarcă în tab-uri separate în aceeaşi
fereastră. Avantajul este că aveţi un control mai mare al desktop-ului pentru că aveţi doar o



fereastră principală. După logout, managementul sesiunii KDE permite salvarea sesiunii de web
în Konqueror. La următorul log in, Konqueror va încărca exact URL-urile vizitate ultima dată.
Pentru a deschide un nou tab, selectaţi Window->New Tab sau apăsaţi Ctrl+ Shift+N. Pentru a
modifica aspectul lui Konqueror mergeţi la Settings->Configure Konqueror. În caseta de dialog
care se deschide, selectaţi Web Behavior->Tabbed Browsing. Pentru a deschide un tab în loc
de o fereastră se activează Open links in new tab instead of in new window.
Bara de tab se poate ascunde cu Hide the tab bar when only one tab is open.
Pentru a vedea alte opţiuni se apasă Advanced Options.

18.1.2 Salvarea paginilor web
Pentru a salva o pagină web, selectaţi Location->Save as şi daţi un nume fişierului HTML. Totuşi
imaginile nu se salvează. Pentru a arhiva o întreagă pagină de web inclusiv grafica se
selectează Tools->ArchiveWeb Page. Konqueror sugerează un nume care se poate accepta.
Numele arhivei se termină cu extensia .war, care este extensia pentru arhivele web. Pentru a
vedea o arhivă salvată se face click pe respectivul fişier şi în Konqueror se va deschide acea
pagină împreună cu imaginile.

18.1.3 Bookmark
În loc să ţinem minte adresele site-urilor care se vizitează în mod frecvent ele se pot introduce în
meniul bookmark. Pentru a crea un nou bookmark în Konqueror, se face click pe Bookmarks-
>Add Bookmark.
Toate bookmark-urile adăugate înainte sunt incluse ca articole în meniu. Este util să se aranjeze
colecţia de bookmark pe subiecte într-o structură de directoare. Creaţi un nou subgrup cu New
Bookmark Folder. Dacă selectaţi Bookmarks->Edit Bookmarks se deschide un editor în care se
pot organiza, rearanja, adăuga şi şterge bookmark-uri.
Salvarea listei şi un acces instantaneu se realizează făcând lista cu bookmark vizibilă în
Konqueror. Selectaţi Settings->Toolbars->Bookmark Toolbar (Konqueror).
Un panou cu bookmark se va afişa automat în Konqueror.

18.1.4 Java şi JavaScript
Java este un limbaj de programare independent de platformă, orientat pe obiect de la Sun
Microsystems. Este folosit frecvent pentru programe de mici dimensiuni (applets), care se
execută în Internet pentru online banking, discuţii (chat) şi cumpărături. JavaScript este un
limbaj de programare utilizat pentru structurarea dinamică a paginilor de web pages, de exemplu
pentru meniuri şi alte efecte.
Konqueror permite activarea sau dezactivarea acestor limbaje. Java şi JavaScript sunt adesea
dezactivate din motive de securitate. Unele pagini web necesită însă JavaScript pentru a fi
afişate corect.
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